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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Introduction 1
1.1 About SINUMERIK

From simple, standardized CNC machines to premium modular machine designs – the 
SINUMERIK CNCs offer the right solution for all machine concepts. Whether for individual parts 
or mass production, simple or complex workpieces – SINUMERIK is the highly dynamic 
automation solution, integrated for all areas of production. From prototype construction and 
tool design to mold making, all the way to large-scale series production.
Visit our website for more information SINUMERIK (https://www.siemens.com/sinumerik). 
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1.2 About this documentation

Target group
This document addresses project engineers, technologists (of the machine manufacturers), 
commissioning engineers (for systems or machines), programmers.

Purpose
This documentation describes the procedure for the system migration from a SINUMERIK 840D 
sl to a SINUMERIK ONE. Because the TIA Portal is prerequisite for configuring this CNC system and 
programming the PLC, these descriptions also contain the migration of the PLC project.

Benefits
This migration manual enables the target group to migrate SINUMERIK 840D sl projects into a 
SINUMERIK ONE project.

Standard scope
This documentation only describes the functionality of the standard version. This may differ 
from the scope of the functionality of the system that is actually supplied. Please refer to the 
ordering documentation only for the functionality of the supplied drive system.
It may be possible to execute other functions in the system which are not described in this 
documentation. This does not, however, represent an obligation to supply such functions with 
a new control or when servicing.
For reasons of clarity, this documentation cannot include all of the detailed information on all 
product types. Further, this documentation cannot take into consideration every conceivable 
type of installation, operation and service/maintenance.
The machine manufacturer must document any additions or modifications they make to the 
product themselves.

Websites of third-party companies
This document may contain hyperlinks to third-party websites. Siemens is not responsible for 
and shall not be liable for these websites and their content. Siemens has no control over the 
information which appears on these websites and is not responsible for the content and 
information provided there. The user bears the risk for their use.

Introduction
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1.3 Documentation on the internet

1.3.1 Documentation overview SINUMERIK ONE
Comprehensive documentation about the functions provided in SINUMERIK ONE Version 6.13 
and higher is provided in the Documentation overview SINUMERIK ONE (https://
support.industry.siemens.com/cs/ww/en/view/109768483).

You can display documents or download them in PDF and HTML5 format.
The documentation is divided into the following categories:
• User: Operating
• User: Programming
• Manufacturer/Service: Functions
• Manufacturer/Service: Hardware
• Manufacturer/Service: Configuration/Setup
• Manufacturer/Service: Safety Integrated
• Information and training
• Manufacturer/Service: SINAMICS

Introduction
1.3 Documentation on the internet
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1.3.2 Documentation overview SINUMERIK 840D sl
You will find extensive documentation on the functions of SINUMERIK 840D sl from version 4.8 
SP4 at 840D sl documentation overview (https://support.industry.siemens.com/cs/ww/en/view/
109766213).

You can display documents or download them in PDF and HTML5 format.
The documentation is divided into the following categories:
• User: Operating
• User: Programming
• Manufacturer/Service: Functions
• Manufacturer/Service: Hardware
• Manufacturer/Service: Configuration/Setup
• Manufacturer/Service: Safety Integrated
• Manufacturer/Service: SINUMERIK Integrate/MindApp
• Information and training
• Manufacturer/Service: SINAMICS

1.3.3 Documentation overview SINUMERIK operator components
Comprehensive documentation about the SINUMERIK operator components is provided in the 
Documentation overview SINUMERIK operator components (https://
support.industry.siemens.com/cs/document/109783841/technische-dokumentation-zu-
sinumerik-bedienkomponenten?dti=0&lc=en-WW).
You can display documents or download them in PDF and HTML5 format.
The documentation is divided into the following categories:
• Operator Panels
• Machine control panels
• Machine Pushbutton Panel

Introduction
1.3 Documentation on the internet
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• Handheld Unit/Mini handheld devices
• Further operator components
An overview of the most important documents, entries and links to SINUMERIK is provided at 
SINUMERIK Overview - Topic Page (https://support.industry.siemens.com/cs/document/
109766201/sinumerik-an-overview-of-the-most-important-documents-and-links?
dti=0&lc=en-WW).

Introduction
1.3 Documentation on the internet
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1.4 Feedback on the technical documentation
If you have any questions, suggestions or corrections regarding the technical documentation 
which is published in the Siemens Industry Online Support, use the link "Send feedback" link 
which appears at the end of the entry.

Introduction
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1.5 mySupport documentation
With the "mySupport documentation" web-based system you can compile your own individual 
documentation based on Siemens content, and adapt it for your own machine documentation.
To start the application, click on the "My Documentation" tile on the mySupport homepage 
(https://support.industry.siemens.com/cs/ww/en/my):

The configured manual can be exported in RTF, PDF or XML format.

Note
Siemens content that supports the mySupport documentation application can be identified by 
the presence of the "Configure" link.

Introduction
1.5 mySupport documentation
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1.6 Service and Support

Product support
You can find more information about products on the internet:
Product support (https://support.industry.siemens.com/cs/ww/en/)
The following is provided at this address:
• Up-to-date product information (product announcements)
• FAQs (frequently asked questions)
• Manuals
• Downloads
• Newsletters with the latest information about your products
• Global forum for information and best practice sharing between users and specialists
• Local contact persons via our Contacts at Siemens database (→ "Contact")
• Information about field services, repairs, spare parts, and much more (→ "Field Service")

Technical support
Country-specific telephone numbers for technical support are provided on the internet at 
address (https://support.industry.siemens.com/cs/ww/en/sc/4868) in the "Contact" area.
If you have any technical questions, please use the online form in the "Support Request" area.

Training
You can find information on SITRAIN at the following address (https://www.siemens.com/
sitrain). 
SITRAIN offers training courses for automation and drives products, systems and solutions from 
Siemens.

Siemens support on the go

Introduction
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With the award-winning "Siemens Industry Online Support" app, you can access more than 
300,000 documents for Siemens Industry products – any time and from anywhere. The app can 
support you in areas including:
• Resolving problems when implementing a project
• Troubleshooting when faults develop
• Expanding a system or planning a new system
Furthermore, you have access to the Technical Forum and other articles from our experts:
• FAQs
• Application examples
• Manuals
• Certificates
• Product announcements and much more
The "Siemens Industry Online Support" app is available for Apple iOS and Android.

Data matrix code on the nameplate
The data matrix code on the nameplate contains the specific device data. This code can be read 
with a smartphone and technical information about the device displayed via the "Industry 
Online Support" mobile app.

Introduction
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1.7 Important product information

Using OpenSSL
This product can contain the following software:
• Software developed by the OpenSSL project for use in the OpenSSL toolkit
• Cryptographic software created by Eric Young.
• Software developed by Eric Young 
You can find more information on the internet:
• OpenSSL (https://www.openssl.org)
• Cryptsoft (https://www.cryptsoft.com)

Compliance with the General Data Protection Regulation
Siemens observes standard data protection principles, in particular the data minimization rules 
(privacy by design).
For this product, this means:
The product does not process or store any personal data, only technical function data (e.g. time 
stamps). If the user links this data with other data (e.g. shift plans) or if he/she stores person-
related data on the same data medium (e.g. hard disk), thus personalizing this data, he/she must 
ensure compliance with the applicable data protection stipulations.

Introduction
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1.8 Notation
The following notation and abbreviations are used in this documentation:
Notation for SINUMERIK machine data (examples):

• MD13370 Machine data 13370
• $MN_SAFE_MODE Machine data type and symbolic name of the machine data
• MD15068[1] Machine data 15068 index 1
• MD15068[1].3 Machine data 15068 index 1 bit 3
• MD15068[0...3] Machine data 15068 index 0 to 3
• MD15068.4 Machine data 15068 bit 4

Notation for PLC blocks:

Startup [OB100] <block name>[<block type><block number>]
Notation for SINAMICS parameters (examples):

• p0918 Adjustable parameter 918
• r1024 Display parameter 1024
• p1070[1] Adjustable parameter 1070, index 1
• p2098[1].3 Adjustable parameter 2098, index 1 bit 3
• p0099[0...3] Adjustable parameter 99, indices 0 to 3
• r0945[2](3) Display parameter 945, index 2 of drive object 3
• p0795.4 Adjustable parameter 795, bit 4

Introduction
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Fundamental safety instructions 2
2.1 General safety instructions

WARNING
Danger to life if the safety instructions and residual risks are not observed 
If the safety instructions and residual risks in the associated hardware documentation are not 
observed, accidents involving severe injuries or death can occur.
• Observe the safety instructions given in the hardware documentation.
• Consider the residual risks for the risk evaluation.

WARNING
Malfunctions of the machine as a result of incorrect or changed parameter settings
As a result of incorrect or changed parameterization, machines can malfunction, which in turn 
can lead to injuries or death.
• Protect the parameterization against unauthorized access.
• Handle possible malfunctions by taking suitable measures, e.g. emergency stop or 

emergency off.
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System Manual, 07/2021, A5E47495977B AD 19



2.2 Warranty and liability for application examples
Application examples are not binding and do not claim to be complete regarding configuration, 
equipment or any eventuality which may arise. Application examples do not represent specific 
customer solutions, but are only intended to provide support for typical tasks.
As the user you yourself are responsible for ensuring that the products described are operated 
correctly. Application examples do not relieve you of your responsibility for safe handling when 
using, installing, operating and maintaining the equipment.

Fundamental safety instructions
2.2 Warranty and liability for application examples
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2.3 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions constitute one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected to 
an enterprise network or the internet if and to the extent such a connection is necessary and only 
when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.
For additional information on industrial security measures that may be implemented, please 
visit 
https://www.siemens.com/industrialsecurity (https://www.siemens.com/industrialsecurity). 
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they are available 
and that the latest product versions are used. Use of product versions that are no longer 
supported, and failure to apply the latest updates may increase customer’s exposure to cyber 
threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under 
https://www.siemens.com/industrialsecurity (https://new.siemens.com/global/en/products/
services/cert.html#Subscriptions). 
Further information is provided on the Internet:
Industrial Security Configuration Manual (https://support.industry.siemens.com/cs/ww/en/
view/108862708)

WARNING
Unsafe operating states resulting from software manipulation
Software manipulations, e.g. viruses, Trojans, or worms, can cause unsafe operating states in 
your system that may lead to death, serious injury, and property damage.
• Keep the software up to date. 
• Incorporate the automation and drive components into a holistic, state-of-the-art industrial 

security concept for the installation or machine.
• Make sure that you include all installed products into the holistic industrial security concept.
• Protect files stored on exchangeable storage media from malicious software by with suitable 

protection measures, e.g. virus scanners.
• On completion of commissioning, check all security-related settings.

Fundamental safety instructions
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Overview 3
3.1 General

SINUMERIK ONE is available as a real controller and also as a virtual controller (Create MyVirtual 
Machine). You can perform the system migration using the virtual control system Create 
MyVirtual Machine or also with the real control system SINUMERIK ONE. Descriptions for 
SINUMERIK ONE are also valid for Create MyVirtual Machine and are equitable in this regard.
Migration procedures that do not concern the SINUMERIK ONE are not described. An overview 
of the documentation for the various migration situations is available at Documentation 
landscape (Page 24). An overview of the migration steps (to a SINUMERIK ONE) is available at 
Overview of the migration procedure (Page 42).
SINUMERIK ONE STEP 7 Toolbox contains various files and libraries that support the migration 
from SINUMERIK 840D sl to SINUMERIK ONE. For an overview, refer to the Included migration 
libraries (Page 29) section.
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3.2 Documentation landscape

Table 3-1 SINUMERIK documentation landscape for the migration depending on the starting system and the target system
To

 
 
 
From

SINUMERIK 840D sl STEP 7 
Toolbox V17
SINUMERIK 840D sl
Safety Integrated (SPL)

SINUMERIK 840D sl STEP 7 
Toolbox V17
SINUMERIK 840D sl
Safety Integrated plus (F-PLC)

SINUMERIK ONE STEP 7 Tool‐
box V17
SINUMERIK ONE
Safety Integrated (F-PLC)

STEP 7 V5.5 SP4 Toolbox
SINUMERIK 840D sl (or high‐
er)
Safety Integrated (SPL)

• Getting Started SINUMER‐
IK 840D sl STEP 7 Toolbox 
V17

• Getting Started SINUMER‐
IK 840D sl STEP 7 Toolbox 
V17

• Safety Integrated plus 
Commissioning Manual

• This documentation
• SINUMERIK ONE Safety In‐

tegrated Commissioning 
Manual

SINUMERIK 840D sl STEP 7 
Toolbox V17
SINUMERIK 840D sl
Safety Integrated (SPL)

N/A • Safety Integrated plus 
Commissioning Manual

• This documentation
• SINUMERIK ONE Safety In‐

tegrated Commissioning 
Manual

SINUMERIK 840D sl STEP 7 
Toolbox V17
SINUMERIK 840D sl
Safety Integrated plus (F-PLC)

N/A N/A • This documentation
• SINUMERIK ONE Safety In‐

tegrated Commissioning 
Manual

Further documentation for SINUMERIK ONE
For the installation, operation and commissioning of SINUMERIK ONE, consult the further 
documentation.
• Create MyVirtual Machine Installation Manual

System prerequisite, installation procedure
• Create MyVirtual Machine System Manual

Functions, operation and configuring
• SINUMERIK ONE Safety Integrated Commissioning Manual
• SINUMERIK ONE upgrade instructions
All documentation is available for download in the SINUMERIK ONE documentation overview 
(https://support.industry.siemens.com/cs/ww/en/view/109768483).

Overview
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General information about migration 4
4.1 Preparations of the starting project

Assuming that you want to migrate from a STEP 7 V5.5 SP4 (or higher) project, you must perform 
several preparatory steps outside the TIA Portal:

Note
SIMATIC STEP 7 V5.5 SP4 and higher
The version of your starting project must be at least that of SIMATIC STEP 7 V5.5 SP4. The 
descriptions in this documentation for SIMATIC STEP 7 V5.5 SP4 also apply for projects which 
were created with versions > SIMATIC STEP 7 V5.5 SP4.

Check whether hardware components can be migrated
With "Readiness Check Totally Integrated Automation Portal" you can check whether 
the associated modules are supported in TIA Portal. If necessary, alternative mod‐
ules are suggested.
Readiness Check Tool in the SIOS (https://support.industry.siemens.com/cs/
document/60162195/)

  
Preparation of the PLC program in STEP 7 V5.5 SP4
Several necessary adaptations to the PLC program must be performed in STEP 7 
V5.5 SP4.

  
Migration of projects with the migration tool
In many cases, the project that you want to migrate is not located on the same PG/
PC on which the current version of the TIA Portal is installed. Consequently, the 
starting project must first be converted to a compatible format for the migration. 
The same applies to integrated projects.
The migration tool is located on the TIA Portal Setup DVD or in the SIOS (https://
support.industry.siemens.com/cs/document/58638200/).

Note
Backing up the starting system
Back up the starting project or system before beginning the migration so you can restore to the 
original at anytime.
To do this, for example, use a separately stored STEP 7 V5.5 SP4 project file and a SINUMERIK 
complete archive.
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4.2 Types of migration
A differentiation is made between the various types of migration that are performed 
successively:

Project migration - migration of a project from STEP 7 V5.5 SP4 to the TIA Portal
The migration to the TIA Portal is called "Project migration". Whereby, all supported components 
of the STEP 7 V5.5 SP4 project are migrated, e.g.:
• SINUMERIK 840D sl, and configured peripherals and modules
• Hardware configuration and interconnection
• PLC program (PLC user program and SINUMERIK basic PLC program)

PLC migration - migration of the PLC program to a SINUMERIK ONE
The migration from 840D sl (PLC 300) to ONE (PLC 1500) is performed within the TIA Portal and 
is called "PLC migration":
• The SINUMERIK ONE is created in the project.
• The PLC program of the SINUMERIK 840D sl is copied to SINUMERIK ONE and adapted 

appropriately.
• The hardware configuration and the network settings of the starting module are not 

transferred automatically.
• The SINUMERIK 840D sl and the associated peripherals and modules remain unchanged in 

the project. The peripherals are not interconnected automatically with the SINUMERIK ONE.
The advantage of migration compared with copying is that the program is adapted 
automatically to the new CPU family as far as possible:
• Program structures that are no longer permitted are updated.
• Operations that are not available on the new module are replaced with corresponding 

S7-1500 operations.

General information about migration
4.2 Types of migration
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Although the migration to SINUMERIK ONE, S7-1500 or ET 200SP follows the same rules, it must 
be performed individually for each PLC program. The PLC programs are treated identical in both 
migration operations.

Note
No cross-migration of blocks with STEP 7 V5.5 SP4 know-how protection
Although blocks with STEP 7 V5.5 SP4 know-how protection can be migrated to the TIA Portal, 
they can no longer be edited and cannot be migrated to SINUMERIK ONE within the TIA Portal 
by the PLC migration.
Consider this for the migration and convert the know-how protection timely, as described in this 
documentation (Page 58).

NC HMI DRV PLCNC HMI DRV PLC

SINUMERIK Archive Migration - Migration of NCK and HMI data to SINUMERIK ONE/Create 
MyVirtual Machine
The migration of all other NCU data is designated as "SINUMERIK archive migration".
You can save all data of the NCU subcomponents in a SINUMERIK archive. You can read this 
archive into SINUMERIK ONE or Create MyVirtual Machine with SINUMERIK Operate. The 
supported data (currently NCK and HMI data) is imported and adapted accordingly for Create 
MyVirtual Machine. In the case of the real SINUMERIK ONE control system, the drive data can 
also be read in. In the following, only NCK and HMI data will be considered for the time being.

General information about migration
4.2 Types of migration
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4.3 SINUMERIK archive migration restrictions
Potential error sources for modified machine data which are to be checked should be considered 
during migration of the NC archive of a SINUMERIK 840D sl into a SINUMERIK ONE.
Possible scenarios for archive migration are described as follows.

Insufficient user memory for PLC scaling
You created an NC archive on a SINUMERIK 840D sl and are importing the archive into a 
SINUMERIK ONE.

Case 1
After loading the archive, alarm 8081 "%1 option(s) is/are activated that are not licensed by the 
license key" is displayed
Cause
The machine data 19270 $ON_PLC_USER_MEM_SIZE in the archive has a value between 0 and 
3. 
Remedy
• Change the value of the machine data to 0. 
Result
The alarm 8081 no longer occurs. If alarm 8023 is additionally displayed, proceed as described 
for Case 2.

Case 2
After loading the archive (or change according to case 1), alarm 8023 "Too much PLC user 
memory used (%1kB)" is displayed.
Cause
More PLC user memory is required than specified in machine data 19270 
$ON_PLC_USER_MEM_SIZE.
Remedy
• Increase the value of the machine data in accordance with the displayed amount of memory 

used.
• To increase the additional PLC memory, the 6FC5800-0BD10-0YB0 option must be available 

and activated on the control.
Result
Alarm 8023 no longer occurs.

General information about migration
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4.4 Deployed software
Various applications and tools that provide support for the various migration steps are available:

TIA

V17

TIA

V17

Note
With the installation of SINUMERIK STEP 7 Toolbox V17, the two components SINUMERIK 840D sl 
STEP 7 Toolbox V17 and SINUMERIK ONE STEP 7 Toolbox V17 are automatically installed.

Upgrading the basic PLC program
The SINUMERIK basic PLC program 6.x contains blocks in the new version with block names 
revised for SINUMERIK ONE that are adapted to the current standard. The system library is 
installed in the TIA Portal via the SINUMERIK ONE STEP 7 Toolbox.

General information about migration
4.4 Deployed software
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The symbols of the blocks have been changed in the context of TIA Portal and SINUMERIK ONE 
and the absolute addressing converted to symbolic addressing.
Principally, symbolic addressing is implemented for SIMATIC S7-1500 and for SINUMERIK ONE. 
The basic program uses symbolic programming and data blocks (classic DBs, no optimized DBs). 
As user you can use the optimized DBs as recommended for S7-1500. Absolute addressing is 
predominantly used for SIMATIC S7-300.
See also: Programming guidelines and programming style guide for S7-1200 and S7-1500 
(https://support.industry.siemens.com/cs/document/81318674)
To ensure compatibility to your existing user program, you must consider the new block names 
for the migration. Depending on the starting system, begin the conversion in STEP 7 V5.5 SP4 
or in the TIA Portal.

Converting the user alarm concept
SINUMERIK ONE is based on the current "Extended DB2 alarms" user alarm concept.
• The "ExtendAlMsg=False" user alarm concept is no longer supported. If you use this concept, 

you must convert to the extended DB2 alarms whose signals use different addresses and 
symbolic identifiers. Depending on the starting system, begin the conversion in STEP 7 
V5.5 SP4 or in the TIA Portal.

• If you already deploy the extended DB2 alarm concept, it is migrated without any additional 
steps, provided you observe the general migration procedure in this document.

Transferring the hardware configuration
SINUMERIK ONE STEP 7 Toolbox
The PLC migration adds a new SINUMERIK ONE with standard configuration to the TIA Portal. 
Consequently, after the PLC migration, the hardware configuration, telegram configuration, etc. 
of the SINUMERIK 840D sl must be transferred to the SINUMERIK ONE settings. Also interconnect 
the SINUMERIK ONE with the original or duplicated peripheral modules. Add the new NX 
modules and interconnect them with the SINUMERIK ONE.

Converting the Safety functionality
SINUMERIK Operate and SINUMERIK ONE STEP 7 Toolbox
• As of SINUMERIK ONE, the integrated SINUMERIK Safety Integrated (SPL) safety concept is no 

longer supported.
• The new drive-based Safety Integrated safety concept combines the safety program known 

from SIMATIC with the drive-integrated SINAMICS Safety Functions, and integrates them in 
the SINUMERIK ONE.

• The drive-based Safety Integrated is designated differently for SINUMERIK 840D sl and 
SINUMERIK ONE.
– SINUMERIK ONE: Safety Integrated
– SINUMERIK 840D sl: SINUMERIK Safety Integrated plus

General information about migration
4.4 Deployed software
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Accordingly, program the safety program in the TIA Portal and configure the drive-integrated 
safety functions with SINUMERIK Operate.
If you use the drive-based SINUMERIK Safety Integrated plus already on the SINUMERIK 840D sl, 
a few adaptations must be performed following migration to the SINUMERIK ONE.

Supplied migration files and libraries
SINUMERIK ONE STEP 7 Toolbox contains various files and libraries that support the migration 
from SINUMERIK 840D sl to SINUMERIK ONE.
These files are located on the product DVD in the following directory: <DVD>\Support\Migration
\

File name Used in Purpose
840Dsl_MigrationDummyLib.zip STEP 7 V5.5 SP4 This library replaces the know-how protected basic 

program blocks with migratable, non-know-how pro‐
tected dummy blocks. Whereby, the interface DBs of 
the basic program are added to the project so it can be 
migrated. As migration preparation, FB4 is replaced 
with a variant that contains the extended interface of 
FB7.
See: Addressing a DB that does not exist in the project 
(Page 39)

LBP_symbols_for_classic_UDT2.asc
or
LBP_symbols_for_classic_UDT1002.asc

STEP 7 V5.5 SP4 This symbol table assigns the symbolic names of the 
basic program V6.x blocks to the basic program V4.X 
blocks.
See: Importing a symbol table with new symbolic 
names of the basic program blocks (Page 52)

SINUMERIK 840D sl Migration 
Dummy Library.zalXX

TIA Portal This library replaces the know-how protected basic 
program blocks with migratable, non-know-how pro‐
tected dummy blocks.
See: Adding dummy blocks to know-how protected ba‐
sic program blocks (Page 73)

General information about migration
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4.5 Scope of migration

4.5.1 Scope of the PLC migration
The PLC migration migrates all components of the PLC program to the newly-created module. 
These include, for example:
• Program blocks of the SINUMERIK PLC basic program without know-how protection (with 

optional user-specific adaptations).
See: PLC basic program (Page 33)

• Program blocks of the PLC user program whose creation language is supported by S7-1500, 
but do not have any know-how protection.

• PLC variable tables
• Monitoring and force tables
• PLC data types
• Technology objects
• User-defined groups in the project navigation

General information about migration
4.5 Scope of migration
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4.5.2 PLC basic program
With regard to the procedure and migration capability, the basic PLC program blocks differ as 
follows in this documentation:
• Migratable basic PLC program blocks: The basic PLC program blocks (mainly DB) that are 

migrated automatically to SINUMERIK ONE during the PLC migration.
These blocks are migrated when you migrate a SINUMERIK 840D sl to a SINUMERIK ONE.
– Interface DBs not present in the project in STEP 7 V5.5 SP4, but assigned only via the 

symbol table, are not created automatically during the project migration. These interface 
DBs can be migrated by adding them as global DB (Page 39) in the project prior to the 
migration.

• Non-migratable basic PLC program blocks: Basic PLC program blocks not migrated, but 
added to the new version 6.x after the migration.
Functions and function blocks (other than FC12) are not migrated, because they do not 
contain any user-specific adaptations and are know-how protected. These FBs and FCs are 
available as new version in the system library.

• No longer supported basic PLC program blocks: If these blocks are contained in your user 
program, delete them and the associated calls or replace them with current basic program 
blocks or standard operations.
– Blocks that are no longer supported with Version ≥ 6.x:

DB2 in the variant "ExtendAlMsg=False", DB4, DB15, DB17, DB18, DB77
(Although these DBs are transferred automatically to the SINUMERIK ONE during the PLC 
migration, they are no longer part of the SINUMERIK basic PLC program ≥ 6.x, and thus no 
longer have any function.)
FB4, FB10, FB11, FB29
FC5, FC22, FC1005, FC1006
Further information can be found in the appropriate table entry for the associated block 
in the Appendix (Page 129).

General information about migration
4.5 Scope of migration
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Table 4-1 Migration of blocks of the basic PLC program ≤ V4.9x and associated blocks
Before migration of an existing 
object

Procedure After PLC migration of an existing object

Organization blocks (OB) The organization blocks contain calls of 
the basic PLC program and calls of your 
user program. Migrate OBs, such as user 
program blocks.

Adapted organization blocks without know-
how protection

Migratable basic PLC program blocks
• All DBs
• FC12 [FC12]
See also: Migratable blocks of the 
PLC basic program (Page 129)

During the migration procedure, replace 
the basic PLC program ≤ V4.9x with basic 
PLC program 6.15 (SINUMERIK ONE), as 
described in this documentation.

Adapted blocks with new block names

Non-migratable basic PLC program 
blocks
See also: Blocks of the PLC basic pro‐
gram that cannot be migrated (au‐
tomatically) (Page 134)

Blocks of the new version with new block 
names

"Diagnostic [FB29]" FB of the basic 
program ≤ V4.9x originally adapted 
as STL source:
• User-defined adapted STL source
• "Diagnostic [FB29]" block gener‐

ated from the source

Diagnostic [FB29] is no longer a direct 
part of the basic PLC program ≥ 6.x.
If you use (or have adapted) Diagnostic 
[FB29], migrate it like a user program 
block.
See also: Migration of external sources 
(Page 58)

Adapted block (STL) without know-how pro‐
tection

Changing the symbolic names
The symbolic names of the basic PLC program blocks of SINUMERIK ONE (firmware version ≥ 6.x) 
differ from those of SINUMERIK 840D sl (firmware version ≤ V4.9x).
• To migrate a STEP 7 V5.5 SP4 project with SINUMERIK 840D sl, adapt the names with the 

supplied symbol table (Page 52).
• To migrate a SINUMERIK 840D sl for a TIA Portal project to a SINUMERIK ONE, you must adapt 

the names successively.

General information about migration
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4.5.3 User alarm concept (DB2)
The ways of creating user alarms differ for the SINUMERIK 840D sl and SINUMERIK ONE CNC 
systems:

Functionality SINUMERIK 
840D sl

SINUMERIK 
ONE

Migration

DB2 alarms without alarm 
extension

supported not supported DB2 alarms without alarm extension are no longer suppor‐
ted by SINUMERIK ONE.
Consequently, the DB2 block is contained only in the ex‐
tended variant in the basic PLC program V6.x (SINUMERIK 
ONE). This means the symbolic identifiers of the interface 
signals and the offset addresses differ.
The Appendix contains a comparison of the addresses in 
DB2 (Page 144) as well as of the symbolic identifiers for 
DB2 signals (Page 145).

DB2 alarms with alarm ex‐
tension

supported supported The extended DB2 alarm concept is migrated, provided you 
observe the general migration procedure in this document.

ALARM_S / ALARM_SQ
(SFC17 / SFC18)

supported not supported These S7-300 operations of the SIMATIC standard scope 
belong to the non-migratable operations. Rather, the Pro‐
gram_Alarm operation is available for the S7-1500.
Further information for the migration of ALARM_S/
ALARM_SQ to Program_Alarm can be found in the follow‐
ing descriptions:
• TIA Portal online help, search term "Migration of 

Alarm_S"
• TIA Portal online help, search term "Notes for non-mi‐

gratable operations"
• FAQ "How in the TIA Portal can alarms be migrated from 

the S7-300/400 to the S7-1500?" (https://
support.industry.siemens.com/cs/document/
69817564/)

The procedure and recommended time for the conversion depend on the starting system and 
the way the user program accesses the DB2 signals:
• If you migrate a STEP 7 V5.5 SP4 project in the TIA Portal and want to work directly with the 

SINUMERIK ONE, convert the user alarm concept in STEP 7 V5.5 SP4 before migrating the 
project (Page 26).

• If you have already migrated your SINUMERIK 840D sl PLC project and have worked in the 
meantime in the TIA Portal, make most of the adaptations in the SINUMERIK ONE after 
the PLC migration (Page 26).

Handling and functionality of the extended DB2 variant 
Differences/commonalities to the unextended DB2 variant
• The user still sets the bits in DB2.
• The parameter assignment via message and alarm is contained in DB5 (rather than DB4).

General information about migration
4.5 Scope of migration
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• The interface signals have different addresses in the DB2 variants, whereby the addresses 
within the individual DB2 alarm areas have the same structure, each displaced by a specific 
value.

• The symbolic identifiers of the DB2 signals are different.
• DB2 and DB3 are not created as CPU DB, but must be contained in the project. These blocks 

are available as global DB in the system library of the basic program.

Note
User-specific definition of user area alarm numbers is no longer supported
To use DB2 alarms with alarm extension, the SINUMERIK 840D sl allows the second digit of the 
alarm number to be defined for each of the 64 user areas (7dx.xxx). The configuration is made 
in DB5 starting at offset 72, array DB5.UserDek2No[0..63].
This configuration option is not supported in SINUMERIK ONE. The second digit of the alarm 
number is always "0" (previous default value).
Further information for any required adaptations to the PLC program and TS files can be found 
at Removing the user-defined numeric value parameter assignment of the 2nd user alarm 
decade (Page 51).

Function extensions
• Support for 10 channels, 31 axes, 64 user areas (the number of user areas must be entered 

in the FC1 parameter "MsgUser").
• Areas for feed stop, read-in disable, etc. are available without messages. The information 

from this area is stored on the interface in DB21 and DB31 depending on FC10 parameter 
"ToUserIF" together with the related message bits as group signals. This avoids the previous 
cumbersome handling of these signals for the unextended variant.

• The alarms/messages for the user area 0 also have 16-bit integer additional values (%Z 
parameter in the alarm text) in addition to the alarm number. The user must write the 16-bit 
integer values in DB2 in the array variable AddValUserA0 in parallel to setting an alarm bit. An 
integer value is available for each bit in the user area 0, see LBP_type_AlarmMsgs (or 
UDT1002) in the basic program.

Name Data type Offset Description
AddValUserA0 Array[0..63] of Int DBW182 Additional value for user alarms 

from user area 0:
700.000…700.063

AddValUserA0[0] Int DBW182 Additional value for user alarm 
700.000 from user area 0

AddValUserA0[1] Int DBW184 Additional value for user alarm 
700.001 from user area 0

AddValUserA0[n] Int DBW(182+2*n) Additional value for user alarm 
700.000 + n from user area 0

AddValUserA0[63] Int DBW308 Additional value for user alarm 
700063 from user area 0

(up to V4.8, array variable "AddValUserA0" was called ZInfo0.)

General information about migration
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For structuring the extended DB2 variant, PLC data type "LBP_type_AlarmMsgs" (up to V4.8: 
UDT1002) is required. 
See also: Interface DB of the PLC basic program (Page 142)
At the start of DB2 there are bit arrays for signals without alarm generation. This is followed by 
an array of size 64 integer values for additional info about the user area 0.
Thereafter follow the areas that also trigger alarms/messages (see List Manual). These areas are 
extended to 10 channels, 31 axes.

4.5.4 Telegram configuration
Because the PLC migration does not include the hardware configuration of the NCU, the 
telegram configuration of the NCU is not migrated automatically.
• After the PLC migration, the SINUMERIK ONE contains the standard telegram configuration 

with the standard I/O addresses.
• The migration of the PLC user program, including accesses to the I/O addresses of the 

telegrams, is part of the PLC migration.
• The migration of peripherals is not part of the PLC migration:

– NX modules must be added again.
– Other peripheral modules can be interconnected with the SINUMERIK ONE after the PLC 

migration.
When for one of the following reasons, you use a telegram configuration that deviates from the 
standard settings of the SINUMERIK ONE, you must make adaptations:
• User-specific telegram I/O addresses, adapted telegram types and additional added 

telegrams are not migrated. PLC variables with telegram I/O address accesses are migrated.
• The standard telegram configuration of a SINUMERIK 840D sl V4.7 or higher that was 

configured with SINUMERIK 840D sl STEP 7 Toolbox V15 or higher differs from that of a 
SINUMERIK ONE. The previously deployed, and so different telegram I/O addresses, are still 
deployed in the migrated PLC variables.

• The Safety Integrated mode and the associated telegrams are not configured automatically 
with the migration. (After migration, reactivate the safety mode in the NCU properties.)
– If you have used Safety Integrated (SPL) previously, you must create a new safety program 

based on your existing safety concept or the risk analysis. Whereby, the changed telegram 
types and I/O addresses must be considered.

– If you have already deployed Safety Integrated plus (F-PLC), the same telegram types are 
deployed on the SINUMERIK ONE, although the telegram I/O addresses differ. The 
previously deployed, and so different telegram I/O addresses, are still deployed in the 
migrated PLC variables and F-peripheral DB names.

If, for the above-mentioned reasons, the PLC variable accesses to telegram I/O addresses differ 
from the configured telegram configuration, you must adapt them.
If, in SINAMICS Integrated, you have deployed a telegram configuration with user-specific I/O 
addresses or already worked in the TIA Portal with a SINUMERIK 840D sl, you must either transfer 
your user-defined telegram configuration or reset the machine data to the default.

General information about migration
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The Appendix (Page 153) provides a tabular overview of the standard telegram configuration, 
incl. the associated machine data.
Note that the telegram types currently supported by Create MyVirtual Machine are a subset of 
the configurable telegram types in the TIA Portal.
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4.6 Addressing a DB that does not exist in the project
Interface DB of the basic SINUMERIK PLC program
SINUMERIK deploys several interface DBs that exist as so-called CPU-DBs on the CPU.
• In STEP 7 V5.5 SP4, you could address the interface DBs without them existing in the STEP 7 

V5.5 SP4 project. The interface DBs for symbolic names and PLC data types (UDT) with the 
declaration of the data structure are assigned via the symbol table.

• In the TIA Portal, symbolic names (and the associated PLC data types) are defined directly in 
the properties of the associated blocks. For this purpose, the associated block must exist in 
the project.

Consequently, add all required interface DBs for axes, channels, mode groups, NC, HMI and tool 
management as global DB to the project. 
Add the interface DB of the basic program as component of the migration library in STEP 7 V5.5 
SP4.
See also: Preparing basic program blocks for migration (Page 54), Interface DB of the PLC basic 
program (Page 142)
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Other DBs not present in the project (e.g. SINUMERIK DB20, user DBs, third-party DBs)
This affects equally all other DBs and DBs from other creators that you address in the user 
program (symbolic or absolute), without them actually being present in the project. In the TIA 
Portal, such blocks must exist in the project.
Ideally, create these blocks before the migration in the STEP 7 V5.5 SP4 project.
• If the UDTs or the assignment in the symbol table exist, add the block as "DB of the type" of 

the associated UDT.
• If you make only absolute access to a block not present in the project, augment it as global 

DB in the project.
See also: Add global DB or DB based on UDT for further blocks (Page 56)
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4.7 Further general information about the migration

Further information about the project migration and PLC migration
General information about the project migration can be found in the TIA Portal online help with 
the search term "Migrate project". You can also find information about the PLC migration in the 
Siemens Industry Online Support:
• Migration of complete systems:

https://support.industry.siemens.com/cs/document/83558085
• Migration of controllers:

https://support.industry.siemens.com/cs/document/83557459
• Migration of visualization:

https://support.industry.siemens.com/cs/document/76878921
• Migration of communication:

https://support.industry.siemens.com/cs/document/83558087
• FAQs on migration:

https://support.industry.siemens.com/cs/document/67858106
If you require further support, contact Customer Support. 

Further information about SINUMERIK in the TIA Portal
The following documents provide specific information for persons converting from STEP 7 V5.5 
SP4 to the TIA Portal or the SINUMERIK 840D sl STEP 7 Toolbox V16 Update 2:
• Functionality comparison and tips for persons converting from a different system:

Getting Started SINUMERIK 840D sl STEP 7 Toolbox V16 Update 2
• Programming recommendations for persons converting from a different system and more 

detailed information for SINUMERIK users:
Application example: Programming recommendation for PLC S7-300 for SINUMERIK - 
preparation for STEP 7 (TIA Portal):
https://support.industry.siemens.com/cs/document/109478721

Further information about SIMATIC/standard functions in the TIA Portal
Further information about SIMATIC and the TIA Portal can be found in the TIA Portal in the 
Siemens Industry Online Support:
https://support.industry.siemens.com/cs/document/65601780
There you will find information on our training offers. For experienced users of the classic 
SIMATIC S7 system who want to migrate efficiently to SIMATIC S7-1500 with the TIA Portal, we 
recommend "TIA-SYSUP - SIMATIC TIA Portal system migration course for SIMATIC S7-1500". 

General information about migration
4.7 Further general information about the migration

Migration to a SINUMERIK ONE
System Manual, 07/2021, A5E47495977B AD 41



4.8 Overview of the migration procedure
Note, depending on your starting project, different migration steps are required, but not all 
migration steps are necessary in all situations. For example, to convert the user alarm concept, 
different variants that show the easiest method for each associated starting situation are 
described.

Example migration procedure: SINUMERIK 840D sl in STEP 7 V5.5 SP4 starting system
Chapter Contents
4 Preparation of the STEP 7 project (Page 45)
5 Migration of the STEP 7 project to a SINUMERIK 840D sl TIA Portal project (Page 65)

After this step, check the migration log and the compilation messages. If errors or warnings occur that can be 
rectified easier in STEP 7 V5.5 SP4, rectify these errors in STEP 7 V5.5 SP4 and repeat the migration.

6 Adaptation of the SINUMERIK 840D sl project in the TIA Portal (Page 69)
7 Migration of the SINUMERIK 840D sl program to a SINUMERIK ONE (Page 77)

You have already performed the steps for converting the user alarm concept to the DB2 variant "Exten‐
dAlMsg=TRUE" for this migration procedure in STEP 7 V5.5 SP4 (see Chapter 5, above).
After this step, check the migration log and the compilation messages. If errors or warnings occur that can be 
rectified easier before the PLC migration, rectify these errors in the SINUMERIK 840D sl PLC project and repeat the 
PLC migration.

8 Make project settings and load project into SINUMERIK ONE/Create MyVirtual Machine (see Create MyVirtual 
Machine System Manual or SINUMERIK ONE STEP 7 Toolbox online help)

9 Create and import archives in SINUMERIK Operate (see Create MyVirtual Machine System Manual or SINUMERIK 
Operate online help)

10 Switch over from the system-integrated Safety Integrated to the drive-based Safety Integrated:
• Activating Safety Integrated in the TIA Portal (Page 123)
• License the software options
• Creating a safety program (Page 125)
• Perform the Safety commissioning

11 Create and save a machine project

Example migration procedure: SINUMERIK 840D sl starting system in the TIA Portal
Chapter Contents
6 Adaptation of the SINUMERIK 840D sl project in the TIA Portal (Page 69)
7 Migration of the SINUMERIK 840D sl program to a SINUMERIK ONE (Page 77)

After this step, check the migration log and the compilation messages. If errors or warnings occur that can be 
rectified easier before the PLC migration, rectify these errors in the SINUMERIK 840D sl PLC project and repeat the 
PLC migration.

8 Make project settings and load project into SINUMERIK ONE/Create MyVirtual Machine (see Create MyVirtual 
Machine System Manual or SINUMERIK ONE STEP 7 Toolbox online help)

9 Create and import archives in SINUMERIK Operate (see Create MyVirtual Machine System Manual or SINUMERIK 
Operate online help)

General information about migration
4.8 Overview of the migration procedure

Migration to a SINUMERIK ONE
42 System Manual, 07/2021, A5E47495977B AD



Chapter Contents
10 Perform the Safety configuration:

• Activating Safety Integrated in the TIA Portal (Page 123)
• License the software options
• Checking the calls of a migrated F-runtime group (Page 126)
• Perform the Safety commissioning

11 Create and save a machine project
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Preparation of the STEP 7 project 5
5.1 Overview

Note
Validity of the description
These descriptions concern the special considerations for the migration of projects that were 
created with SINUMERIK 840D sl STEP 7 Toolbox for STEP 7 V5.5 SP4 (or higher). The migration 
notes and descriptions for STEP 7 (TIA Portal) also apply.
If you want to migrate components that require further option packages, the migration notes of 
the associated documentation also apply.
A selection of general migration descriptions and notes are available at Further information 
(Page 41).

Several necessary adaptations to the PLC program must be performed in STEP 7 V5.5 SP4.

Requirement
• The project to be migrated is upgraded to SINUMERIK 840D sl STEP 7 Toolbox 4.5 SP2 (or 

higher) for STEP 7 V5.5 SP4 (or higher).
• The project does not contain any blocks that are no longer supported with the current 

SINUMERIK 840D sl basic program versions.
See also: Migration scope (Page 33)

• The STEP 7 project to be migrated is consistent and can be compiled without error.
• All option packages used to create the project in STEP 7 V5.5 SP4 are installed and licensed 

(e.g. the option package for SCL or the F-configuration tool).

Handling overview
Step Description
1 Check the hardware support (readiness check)

Before the migration, use the "Readiness Check Totally Integrated Automation Portal" to check whether the mod‐
ules of your project are supported:
https://support.industry.siemens.com/cs/document/60162195/
If modules are not supported in the TIA Portal, alternative modules will be suggested by this tool.

2 Convert ALMSG [DB2] to the PLC alarm extension (Page 47)
If you do not use the extended variant of DB2, begin with the conversion here.

3 Removing the user-defined numeric value parameter assignment of the 2nd user alarm decade (Page 51)
If you have adapted the 2nd digit (2nd decade of alarm number 7dx.xxx) user-defined for the DB2 alarms in the 
user area (alarm numbers 7dx.xxx), you must remove these adaptations.

4 Importing a symbol table with new symbolic names of the basic program blocks (Page 52)
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Step Description
5 Preparing basic program blocks for migration (Page 54)
6 Add global DB or DB based on UDT for further blocks (Page 56)
7 Checking the migration capability of blocks/sources (Page 58)
8 Preparing the conversion from FB4 to LBP_ReqPIService [FB7] (Page 62)

If you use FB4, make the adaptations for the conversion to FB7 in this migration step.
9 Checking the user program for required adaptations (Page 63)
10 Convert the starting project to a migration file

• If STEP 7 V5.5 SP4 and the TIA Portal are not installed on the same PG/PC, or the starting project is an integrated 
project, you must convert the starting project to a migration file using the migration tool.
See: TIA Portal online help, search term "migration tool"

• If you do not deploy the migration tool, STEP 7 V5.5 SP4 and TIA Portal must be installed on the same PG/PC, 
each with all required option packages.

Preparation of the STEP 7 project
5.1 Overview
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5.2 Converting ALMSG [DB2] to the PLC alarm extension
Unlike SINUMERIK 840D sl, the SINUMERIK ONE DB2 alarms can be deployed only in the variant 
"ExtendAlMsg=True" (PLC alarm extension).
We recommend that the conversion to the PLC alarm extension is performed before the 
migration of the SINUMERIK project in STEP 7 V5.5 SP4. 

Note
External source files are not changed by the conversion
If you use external source files (e.g. STL or SCL) from which the blocks are generated for your user 
program, the DB2 accesses in the generated blocks are converted during this migration step. The 
program code in the sources, however, is not changed.
If you want to reuse the external source files in the TIA Portal, you must separately adapt the 
contained DB2 accesses (and import the external sources separately).
See also: Migration of external sources (Page 58)

Note
Comments in the program code are not changed
If your program code uses comments for documentation in which absolute addresses or 
symbolic identifiers occur, they may need to be adapted separately. Comments are not 
considered during this migration step.

Note
The procedure described here allows most accesses to DB2 signals in your user program to be 
identified. However, depending on the project, it is possible that all partially qualified DB2 
accesses are not necessarily found via the cross-reference list.

5.2.1 Overview

Requirement
• DB2 is added to the starting project prior to migration based on UDT2.

Preparation of the STEP 7 project
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Overview
Step Procedure
1 Assign the DB2 offsets the symbols of the extended DB2 variant (Page 48)

If you access only absolute addresses of DB2, you can skip this step.
2 Adapt the accesses to DB2 depending on the access type:

• Direct access to DB2 with absolute signal addresses (Page 48)
• Indirect access to DB2 using user DB and BLKMOVE operation (Page 49)
If you access DB2 sometimes via BLKMOVE and sometimes absolutely direct, you must make both adaptation steps.
• Direct symbolic accesses to DB2 have already been adapted in Step 1.

See also
Addressing a DB that does not exist in the project (Page 39)
Importing a symbol table with new symbolic names of the basic program blocks (Page 52)

5.2.2 Assigning DB2 offsets the symbols of the extended DB2 variant
The source container of the basic program contains the "udt2_for_Convert.awl" file, which has 
the following structural element from UDT1002:
• ChanA as array of 1 ... 8
• AxisA as array of 1 ... 18
• UserA as array of 0 ... 63
This STL file can be used to create a UDT that assigns the offsets of the DB2 variant 
"ExtendAlMsg=False" the symbolic names of the DB2 variant "ExtendAlMsg=True".

Basic procedure
To assign DB2 offsets of the variant "ExtendAlMsg=False" the symbols of the variant 
"ExtendAlMsg=True", proceed as follows:
1. Compile the "udt2_for_Convert.awl" file.

This creates a UDT2 that contains an assignment of the DB2 offsets to the symbols of the new 
DB2 variant.

2. Open the symbol table and assign DB2 the newly-created UDT2.

5.2.3 Conversion for direct absolute access to ALMSG [DB2]

Requirement
• DB2 based on UDT2 is added to the project.

Preparation of the STEP 7 project
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Basic procedure
To convert the access to absolute signals from DB2 in STEP 7 V5.5 SP4, proceed as follows:
1. To find the affected blocks in your user program, use the cross-reference list ("Options > 

Reference data > Displays" menu command).
2. Open the affected program locations successively and convert the offset addresses of the 

associated DB2 signals. The new offset address results from the sum of the previous address 
and the "offset".

Example 1
OPN DB2
...
CLR
S %DBX<Bit in DB2>

Example 2
OPEN DB2
...
L 0
T DBB<Byte in DB2>

Note
Finding DB2 accesses in the user program
Not all DB2 accesses are found via the reference data. Accesses via BLK_DB or pointer are not 
detected.

A comparison of the associated offset addresses and the address offset can be found in the 
appropriate table (Page 144).

5.2.4 Conversion for indirect access via BLKMOV
The following adaptations are necessary when you do not directly access ALMSG [DB2], but 
instead use BLKMOV to copy memory areas of your own data blocks to ALMSG [DB2].

5.2.4.1 Checking and adapting copied memory areas
The offset addresses of both DB2 variants have the same structure within the individual DB2 
areas1, each offset by a specific value. This offset is, however, different for each DB2 area.
Check whether you use BLKMOV copy operations that copy a memory area larger than a DB2 
area. If you copy such memory areas, you must divide the copy operation into several operations.
1See: "Area" column in the Comparison of offsets in DB2 variants (Page 144) table
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Basic procedure
To divide the BLKMOV operations, proceed as follows:
1. To find the affected program locations in your user program, use the cross-reference list 

("Options > Reference data > Displays" menu command).
2. Open those blocks with BLKMOV copy operations that copy the data of multiple DB2 areas 

concurrently (or copy a memory area larger than a DB2 area).
3. Divide the associated BLKMOV operations into several operations so that each copies the 

data of just one area.
The individual DB2/alarm number areas can be found at Comparison of the addresses in DB2 
(Page 144).

5.2.4.2 Adapting the copy target for BLKMOV
The offset addresses of both DB2 variants have the same structure within the individual DB2 
areas1, each offset by a specific value. This offset is, however, different for each DB2 area. 
Consequently, you must consider the new offset address appropriate for the associated DB2 area 
and adapt it appropriately.
1See: "Area" column in the Comparison of offsets in DB2 variants (Page 144) table

Basic procedure
To adapt the target memory addresses for BLKMOV operations by copying the data to DB2, 
proceed as follows:
1. To find the affected program locations in your user program, use the cross-reference list 

("Options > Reference data > Displays" menu command).
2. Open those blocks that copy data via BLKMOV to DB2.
3. Change each offset address of the BLKMOV target memory area. The new offset address 

results from the sum of the previous address and the "offset".
A comparison of the associated offset addresses and the address offset can be found in 
the appropriate table (Page 144).
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5.3 Removing the user-defined numeric value parameter assignment 
of the 2nd user alarm decade

If you have adapted the 2nd digit (2nd decade of alarm number 7dx.xxx) user-defined in the user 
area (alarm numbers 7dx.xxx), you must remove these adaptations. SINUMERIK ONE does not 
support values that differ from the standard "0".
After the PLC migration to SINUMERIK ONE, any existing values for the "2nd decade" in 
LBP_ParamAlarmMsgs [DB5] have no effect. The existing DB5 array "UserDek2No [.]" in the 
SINUMERIK 840D sl basic PLC program has been renamed as "ByteArray72 [.]".

Basic procedure
To remove the user-defined numeric value parameter assignment of the 2nd user alarm decade, 
proceed as follows:
• In LBP_ParamAlarmMsgs [DB5], set all values in LBP_ParamAlarmMsgs.ByteArray72[.] to 0.

Values that differ from the standard value 0 have no effect.
• If the PLC program writes these values with program operations (such as in OB100) in the 

LBP_ParamAlarmMsgs [DB5], these operations must be removed.
• In the TS files, change (with SINUMERIK Operate) the definition of the alarm texts for alarms 

7dx.xxx so that only alarm numbers 70x.xxx are used. To do this, search the TS files for entries 
with the element <source> and change the associated alarm number.
These changes must be made before you create the SINUMERIK 840D sl archive for the 
archive migration.

Further information 
Further information about specifying alarm texts can be found in the SINUMERIK Operate (IM9) 
Commissioning Manual at "Configuring alarms".
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5.4 Importing a symbol table with new symbolic names of the basic 
program blocks

The symbolic names of the basic PLC program blocks of SINUMERIK ONE (firmware version 6.x) 
differ from those of SINUMERIK 840D sl (firmware version ≤ 4.9x).
As appropriate for the currently used ALMSG[DB2] layout, use one of the following supplied 
symbol tables to adapt the block names automatically:

DB2 version UDT Symbol table
DB2 without alarm extension UDT2 LBP_symbols_for_classic_UDT2.asc
DB2 with alarm extension UDT1002 LBP_symbols_for_classic_UDT1002.asc

Requirement
• The required symbol file is available on the PG/PC or the product DVD of the SINUMERIK ONE 

STEP 7 Toolbox V16 Update 2 is inserted.
This file can be found in the "Support\Migration" directory on the product DVD of the 
SINUMERIK ONE STEP 7 Toolbox.

• The project to be migrated is open in STEP 7 V5.5 SP4.
• Block number ranges of the SINUMERIK basic program in the project are not assigned blocks 

from other creators, e.g. user blocks, or third-party blocks or blocks from other Siemens 
products (e.g. DB_HMI [DB59] from Transline).
The block number ranges of the SINUMERIK basic program are shown in the tables in the 
Appendix (Page 129).
Note
Procedure for the assignment of the SINUMERIK number range by blocks from other 
creators
When you import the migration symbol table as described below, all blocks in the SINUMERIK 
number range are assigned the new symbolic names of basic program V6.x. The import 
operation cannot check whether the SINUMERIK number range is used for other blocks.
If you use the SINUMERIK number range for other blocks, before importing, open the symbol 
file (LBP_symbols_for_classic_UDT2.asc or LBP_symbols_for_classic_UDT1002.asc) in an 
external editor and delete those block entries assigned in your project by blocks from other 
creators. Save the file with a new name and use your modified file rather than the original.
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Procedure
To update the names of the basic PLC program before migration, proceed as follows.
1. In the STEP 7 V5.5 SP4 project window, double-click the symbol table.

The symbol editor opens.

2. Select the "Table > Import..." menu command.
3. Switch in the "Import" dialog to the desired file ("LBP_symbols_for_classic_UDT2.asc" or 

"LBP_symbols_for_classic_UDT1002.asc" or a customized symbol file) in the appropriate 
directory and confirm with "Open".
The symbol table is imported:
– Blocks of the SINUMERIK basic PLC program without symbolic names are assigned the 

new block name.
– Any previously defined symbols in the block number range of the basic program are 

overwritten with the new symbols.
– The message "Import result" is displayed and a new log file is created.

4. Save the symbol table with the "Table > Save" menu command.

Further information
Detailed information about symbol tables can be found in the Programming with STEP 7 manual 
or in the STEP 7 V5.5 SP4 online help.
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5.5 Preparing basic program blocks for migration

5.5.1 Dearchiving and opening the basic program migration library

Requirement
• The file "840Dsl_MigrationDummyLib.zip" is available on the PG/PC or the product DVD of the 

SINUMERIK ONE STEP 7 Toolbox V16 Update 2 is inserted.
This file can be found in the "Support\Migration" directory on the product DVD.

• The project to be migrated is opened in STEP 7 V5.5 SP4 or higher.

Procedure
To open the basic program migration library in STEP 7 V5.5 SP4, proceed as follows:
1. Select the "Dearchive" command in the "File" menu.
2. Switch to the "Support\Migration" directory on the product DVD, select the 

"840Dsl_MigrationDummyLib.zip" file, and confirm with "Open".
3. Select the "s7libs" folder as target directory in the STEP 7 V5.5 SP4 installation directory.
4. Select the "Open" command in the "File" menu, select the "840Dsl_MigrationDummyLib" 

library in the "Libraries" tab, and confirm with "OK".

5.5.2 Replacing basic program blocks with migration blocks and dummy blocks

Requirement
• The project to be migrated is open in STEP 7 V5.5 SP4.
• The "840Dsl_MigrationDummyLib" library is open (Page 54).
• Block number ranges of the SINUMERIK basic program in the project are not assigned blocks 

from other creators or you have checked which blocks from other creators are located in 
the SINUMERIK number range (Page 129).
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Procedure
To replace the basic program blocks in your project with migration blocks and dummy blocks, 
proceed as follows.
1. Check which migration blocks and dummy blocks you require from the library.

 Select the required migration blocks and dummy blocks, and copy them to the clipboard.

Block Purpose/procedure
Data blocks These DBs are required in the TIA Portal project, because addressed in‐

terface DBs must exist in the project.
See also: Addressing a DB that does not exist in the project (Page 39)
• Before copying, check that these number ranges of the basic program 

have not been used for user blocks or third-party blocks. These blocks 
may be used only to overwrite basic program blocks.

DB21…DB30 Select the actually used axis/channel DB.
DB31…DB61

Function blocks /
functions

These FBs/FCs do not contain the actual program code, but rather the 
associated interfaces and inputs/outputs. This means they are retained 
for the migration, after which they can be replaced with complete blocks 
of basic PLC program V6.x.
Overwrite existing basic program FBs/FCs in your project with the asso‐
ciated basic program FBs/FCs.

FB4 To simplify the conversion, FB4 from this migration library contains the 
extended interface of FB7.
If you already use FB7, you do not require this FB4.
See also: Preparing the conversion from FB4 to LBP_ReqPIService [FB7] 
(Page 62)

(If the basic program block number range is not assigned blocks from other creators, you can 
select and copy all blocks.)

2. Insert the copied blocks from the clipboard in the "Blocks" folder in your project. Whereby, 
overwrite any existing basic program blocks.

Result
The deployed basic program blocks have been replaced with blocks from the migration library:
• Deployed interface DBs have been added to the project as global DBs, as required in the TIA 

Portal.
• Deployed know-how protected basic program blocks have been replaced with dummy blocks 

that can be migrated.
• If you use FB4, it has been replaced with a variant that simplifies conversion to the extended 

FB7. 
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5.6 Add global DB or DB based on UDT for further blocks
In the TIA Portal, addressed or deployed DBs must exist in the project.
See also: Addressing a DB that does not exist in the project (Page 39)
For example, if you access DB20, add this as global DB in the project.

Note
If you access DB2 in the extended variant ("ExtendAlMsg = True"), but this DB does not exist in 
your project, create it based on UDT1002.
If you access DB2 in the small variant ("ExtendAlMsg = False"), you have created it based on UDT2 
already for the conversion to the PLC alarm extension (see "Converting ALMSG [DB2] to the PLC 
alarm extension (Page 47)").

Procedure
To create an addressed, but non-existent, data block in the project based on a UDT, proceed as 
follows:
1. In the STEP 7 V5.5 SP4 project window, right-click the "Blocks" folder and select the "Add new 

object > Data block" command.
The "Properties - Data block" dialog opens.

2. In the "Name" and "Type" fields, enter the block address, then select "DB of type" and the 
associated UDT.

3. Enter the symbolic name and confirm with "OK".
To create an addressed, but non-existent, data block as global DB in the project, proceed as 
follows:
1. In the STEP 7 V5.5 SP4 project window, right-click the "Blocks" folder and select the "Add new 

object > Data block" command.
The "Properties - Data block" dialog opens.

2. In the "Name" and "Type" fields, enter the block address, then select "Global DB".
3. Enter the symbolic name and confirm with "OK".
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DB20 example
To prepare DB20 for use in the SINUMERIK ONE environment, the data arrays must be created in 
accordance with the number of PLC machine data items in DB20 to be transferred:

PLC machine data
For the SINUMERIK 840D sl, the PLC machine data was typically stored in the DB20 during run-
up of the PLC. With SINUMERIK ONE, the PLC machine data is supplied at the parameters of 
"LBP_ConfigBP [FC1]". As an alternative to arrays, structures or PLC data types can be used.
A description of the PLC machine data can be found in the SINUMERIK ONE PLC Function Manual 
using the keyword "PLC machine data" in the section "LBP_ConfigBP [FC1]".

See also
Replacing the call of LBP_ConfigBP [FB1] in OB Startup [OB100] with LBP_ConfigBP [FC1] 
(Page 109)

Preparation of the STEP 7 project
5.6 Add global DB or DB based on UDT for further blocks

Migration to a SINUMERIK ONE
System Manual, 07/2021, A5E47495977B AD 57



5.7 Checking the migration capability of blocks/sources

5.7.1 Migration of external sources
If the STEP 7 V5.5 SP4 project uses external sources, the sources are not migrated, but rather the 
blocks generated from these sources.

Note
Using external sources in the TIA Portal
If you want the STL/SCL sources in the TIA Portal still to be treated as external sources, and to be 
opened and edited with an external editor, they must be imported explicitly into the TIA Portal.
Further information about working with external sources can be found in the TIA Portal online 
help, search term "External source".

Blocks generated from external sources can be edited after the migration, provided they were 
not know-how protected before the migration (Page 58).

5.7.2 Checking know-how protected blocks
In STEP 7 V5.5 SP4, know-how protected blocks cannot be migrated to a SINUMERIK ONE.
• The migrated blocks with STEP 7 V5.5 SP4 know-how protection can run in the TIA Portal with 

a SINUMERIK 840D sl.
• The blocks can no longer be edited, because the program code is not migrated automatically.
Consequently, use the following tables to check how the know-how protection of the associated 
blocks can be removed.
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Overview
The procedure for migrating a know-how protected block is different depending on the owner 
of a know-how protected block and the type of the know-how protection.

Table 5-1 Migration of user-written know-how protected blocks of the user program
Before migration of existing ob‐
jects

Procedure After PLC migration of an existing object

Know-how protected block original‐
ly programmed as STL source:
• STL source with keyword 

"KNOW_HOW_PROTECT"
(possibly removed from the 
project)

• Generated know-how protected 
block (STL)

If the original source was programmed in 
STL, if necessary, add it again to the 
project, remove the keyword 
"KNOW_HOW_PROTECT" and generate 
the block again (Page 60).

Adapted block (STL) without associated 
source and without know-how protection

Know-how protected block original‐
ly programmed as SCL source:
• SCL source (possibly removed 

from the project)
• STL source created from SCL 

source with keyword 
"KNOW_HOW_PROTECT"
(possibly removed from the 
project)

• Generated know-how protected 
block (STL)

If the original source was programmed in 
SCL and then protected with keyword 
"KNOW_HOW_PROTECT" in STL, add the 
original SCL source to the project and gen‐
erate the block again.

Adapted block (SCL) without associated 
source and without know-how protection

FB/FC with improved know-how pro‐
tection "S7-Block Privacy" (pass‐
word-based)

Remove the improved STEP 7 V5.5 SP4 
know-how protection "S7-Block Privacy" 
before migration to STEP 7 V5.5 SP4 as 
described in the following FAQ:
SIOS, Entry ID: 45632073 (https://
support.industry.siemens.com/cs/
document/45632073/)

Adapted FB/FC without know-how protec‐
tion

After migration, you can reactivate the know-how protection of your blocks while using the 
newer, password-based variant of the know-how protection in the TIA Portal. 
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Table 5-2 Migration of know-how protected blocks from other creators (third-party manufacturer or blocks from other 
Siemens option packages or products)

Before migration of an existing 
object

Procedure After PLC migration of an existing object

Block with know-how protection of 
any type

Obtain the appropriate new blocks that 
can run on SINUMERIK ONE from the cre‐
ator of the blocks. Contact the creator of 
the blocks.

New, operational block with know-how pro‐
tection

If these blocks have been announced by 
the creator, but are not yet available at the 
specified time, you can use a workaround 
(Page 75) temporarily.
This workaround is handled in the TIA Por‐
tal, i.e. after project migration and before 
the PLC migration. 
In this way, you can already migrate the 
other components and add the missing 
blocks later. The functionality of the miss‐
ing blocks, however, is available only after 
adding the complete blocks.

Dummy block without function and with‐
out know-how protection that contains on‐
ly the block name and parameters or inputs 
and outputs

Further information
• A table with information about the migration of basic PLC program blocks (Page 34) can be 

found at "Migration scope".
• Information about the migration of user-written know-how protected blocks of the user 

program can be found in the TIA Portal online help, search terms "Migration of LAD/FBD/STL 
programs", "Protect blocks"

• Information about the migration of SIMATIC blocks and operations can be found in the TIA 
Portal online help, Chapter "PLC migration".

See also
PLC basic program (Page 33)

5.7.3 Revoking know-how protection of type "KNOW_HOW_PROTECT"

Requirement
• The external source of the know-how protected block exists in the project.

If you do not have the source of a know-how protected block, you cannot deactivate the 
know-how protection and cannot migrate the block.
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Procedure
To remove the know-how protection of a block based on an external source, proceed as follows:
1. In the "Sources" folder of your S7 program, open the source of the know-how protected block.
2. Delete the function "KNOW_HOW_PROTECT" in the source code.
3. Select the "Save" command in the "File" menu.
4. Select the "Compile" command in the "File" menu.

Result
A block without know-how protection was created from the source that can be migrated.
After migration, you can reactivate the know-how protection, while using the newer, password-
based variant of the know-how protection.

More information
Information about know-how protected blocks of the user program can be found in the TIA 
Portal online help, search terms "Migration of LAD/FBD/STL programs", "Protect blocks"
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5.8 Preparing the conversion from FB4 to LBP_ReqPIService [FB7]
When, as part of the migration you convert from FB4 to FB7, perform a compilation in this 
migration step.
If you have already deployed PI_SERV2 [FB7] before the migration, skip this migration step.

Requirement
• PI_SERV [FB4] is replaced (Page 54) with LBP_ReqPIService_MigFB4 [FB4] from the migration 

library.
• The symbol table is imported. (Page 52)

Procedure
To convert the parameter transfer of the FB4 calls to the extended FB7 interface, proceed as 
follows:
1. In the STEP 7 V5.5 SP4 project window, right-click the "Blocks" folder and select the "Check 

block consistency" command.
The "Check block consistency" editor opens.

2. Select the "Compile all" command in the "Program" menu.

Result
The compilation transferred the parameter transfer for FB4 calls to the extended interface for 
FB7 contained in LBP_ReqPIService_MigFB4 [FB4]. In a later migration step (after the project 
migration and the PLC migration), complete the conversion to FB7 (Page 90).
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5.9 Checking the user program for required adaptations
STEP 7 (TIA Portal) contains not only the new user interface and operation, but also several 
functional changes and innovations for handling the PLC program. For example, in the TIA 
Portal, each block has a number and a name, and the symbolic addressing takes precedence.
During the migration of the user program, a symbol and a data type are assigned automatically 
to each deployed absolute address (e.g. flags, I/O addresses). In addition, stricter rules for 
checking data type compatibility are deployed in the TIA Portal.
In particular, the following calls or procedures in the user program can cause problems with the 
migration:
• Implicit type conversions of absolute addresses that differ from the declared data type
• Saving intermediate results with absolute addresses or global flags without declared data 

type
• Saving different data types in the same address area
• Writing input parameters or reading output parameters
• Absolute addressing of the local data stack
• Conditional opening of a DB with subsequent partially qualified addressing (see Example)
Consequently, adapt your user program before you migrate your project to the TIA Portal. For 
more detailed information, see the following application example:
• Programming recommendation for PLC S7-300 for SINUMERIK - preparation for STEP 7 (TIA 

Portal) (https://support.industry.siemens.com/cs/document/109478721/)
The following product support-pages also provide programming recommendations for 
migrating:
• Programming recommendations for S7-1200/S7-1500 (https://

support.industry.siemens.com/cs/document/67582299/)
• Further programming recommendations for S7-1500 (https://

support.industry.siemens.com/cs/document/67858106)
Changes to the user program required by innovations of basic PLC program 6.x are covered by 
the migration steps in this documentation.

Using the migration log and compilation messages to identify any migration problems in 
advance
As preliminary test, perform the project migration and PLC migration to identify early any 
required changes to your user program.
Rectify any problems from the messages on the starting project in STEP 7 V5.5 SP4 or in the TIA 
Portal before the PLC migration.
See: Migration log and compilation messages (Page 150)
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Migration of the STEP 7 project to a SINUMERIK 840D 
sl TIA Portal project 6
Requirement

• The project has been converted with the migration tool to the AM14 format or STEP 7 as of 
V5.5 SP4 and the TIA Portal are installed on the PG/PC (each with all deployed option 
packages).

• The project to be migrated is upgraded to SINUMERIK 840D sl Toolbox as of 4.5 SP2 for STEP 7 
as of V5.5 SP4.

• The project to be migrated contains only those modules supported in the TIA Portal.
Use the Readiness Check Tool to check whether the modules used are supported. Alternative 
modules will be displayed if modules are not supported in the TIA Portal.

• The STEP 7 project to be migrated is consistent and can be compiled without error.
If your project cannot be executed, you must correct it in STEP 7 V5.5 SP4, before you migrate 
it. You can check the consistency with SIMATIC Manager and restore by compiling the blocks.

• The STEP 7 project to be migrated does not have access protection.
Observe any additional notes for the requirements in the help for the associated installed 
products.

Note
System hibernation during the migration
While a migration is running, the system should not be changed to the standby or hibernate 
mode. Otherwise the migration will be aborted.
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Procedure   
To migrate a STEP 7 V5.5 SP4 project to the TIA Portal, proceed as follows:
1. Select the "Migrate project" command in the "Project" menu.

The "Migrate project" dialog opens.
2. Specify the path and the file name for the project to be migrated in the "Source path" field. 

Select either a project in migration format ".am14" or in STEP 7 V5.5 SP4 format ".s7p".

3. Make any necessary additional settings:

Option Remark
Include hardware configu‐
ration

Activate this checkbox so that the modules, incl. configuration, are mi‐
grated. Otherwise, only the PLC program is migrated.
If you have selected a migration file that was created with the migration 
tool, the checkbox cannot be activated. In this case, you must specify 
whether you want to include the hardware configuration in the migra‐
tion before the conversion with the migration tool .

Project name Name of the TIA Portal project. It is also the same name as the file name 
without file extension.

Target path The path in which the new project is created.
For example, projects newly-created with the TIA Portal are stored at the 
following location by default:
C:\Users\<user rname>\Documents\Automatisierung\

Author The author responsible for the project.
This entry can be viewed in the project properties and changed subse‐
quently.

Comment Optional comment for the project.
This entry can be viewed in the project properties and changed subse‐
quently.

4. Click "Migrate".
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Result
The starting project is converted and a message displayed after the conversion is complete. The 
newly-created project is then opened in the project view, and the migration log is opened in the 
TIA Portal.
Check the migration log (Page 150) to assess whether you can continue working with the 
migrated project or whether you must rectify certain problems in STEP 7 V5.5 SP4 and migrate 
the project again.
Even if the migration failed, a project directory is created and a migration log in the form of an 
XML file is generated in this directory. The completion message that appears after the migration 
contains a link to this XML file. Click the link to open the XML file. Alternatively, you can find the 
XML file in the project directory at "\Logs".
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Adaptation of the SINUMERIK 840D sl project in the 
TIA Portal 7
Overview

Depending on your starting system and project, you may need to perform further steps prior to 
the PLC migration to a SINUMERIK ONE.

Step Procedure
1 Renaming basic program blocks (Page 70)

To migrate a SINUMERIK 840D sl to a SINUMERIK ONE from a TIA Portal project, you must change the symbols.
If instead, to migrate from a STEP 7 V5.5 SP4 project, the symbols have already been adapted in a previous step.

2 Adding dummy blocks to know-how protected basic program blocks (Page 73)
To migrate a SINUMERIK 840D sl to a SINUMERIK ONE from a TIA Portal project, you must add migration-capable 
dummy blocks here.
This retains the accesses to interfaces and inputs/outputs of the basic PLC program blocks after the migration.

3 Converting a know-how protected block to a dummy block without function (Page 75)
If your project contains know-how protected blocks from other creators that are currently not yet available for 
SINUMERIK ONE, you can use this workaround temporarily.
This allows converted blocks to be transferred during the PLC migration without causing any error messages, but 
do not have any function, and so must be replaced subsequently with functional blocks.

4 Removing the Safety Integrated (SPL) program (Page 76)
Safety Integrated (SPL) is not supported by SINUMERIK ONE. If you have deployed this Safety operating mode, you 
must adapt the PLC program before the migration.
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7.1 Renaming basic program blocks
Changing the symbolic names
The symbolic names of the basic PLC program blocks of SINUMERIK ONE (firmware version 6.x) 
differ from those of SINUMERIK 840D sl (firmware version ≤ 4.9x).
• If you migrate with SINUMERIK 840D sl from a STEP 7 V5.5 SP4 project, the symbols have 

been adapted automatically with the supplied symbol list (Page 52).
• To migrate a SINUMERIK 840D sl to a SINUMERIK ONE from a TIA Portal project, you must 

change the symbols.
By adapting the symbolic names of the basic PLC program blocks, for example, the calls of the 
basic program blocks in the user program are changed so they match the future symbols.

Requirement
• The STEP 7 V5.5 SP4 project has been migrated to the TIA Portal (without adapting the 

symbolic block names using the symbol list)
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Procedure
To change the symbolic names of the basic PLC program blocks, proceed as follows:
1. You have several options for displaying the basic program blocks:

– In the project navigation, open the Program Blocks folder below the PLC (e.g. "CNC_1 > 
PLC_1 > Program Blocks").

– Select the Program Blocks folder below the PLC, click the "Maximizes/minimizes the 
overview" symbol and switch to the "Details" tab.

Figure 7-1 Project navigation

Figure 7-2 Detailed view of the basic program blocks

The blocks can be sorted in the maximized overview, e.g. according to address, author or 
family.
If the blocks are structured into groups or subfolders, the "Display lower-level elements" 
button is enabled.

2. Select the associated block names successively and change them with F2 or the "Rename" 
context menu command.
The "Comparison of the old and the new symbolics of the basic program blocks (Page 142)" 
table provides a comparison of the symbolic names sorted according to the absolute address.
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Result
The symbolic block names have been changed, whereby the symbolic calls of the blocks in the 
PLC program were updated automatically.

Result and effects for the conversion of a DB2 user concept of a TIA Portal project
If the DB2 alarm concept in the TIA Portal is converted, the PLC program calls are changed from 
"ALMSG_DB" to "LBP_AlarmMsgs", but not the symbolic signal identifiers or addresses. They 
must be adapted after PLC migration.
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7.2 Adding dummy blocks to know-how protected basic program 
blocks

A dummy library with basic PLC program blocks in a non-know-how protected variant is 
contained on the product DVD of the SINUMERIK ONE STEP 7 Toolbox. The blocks of this dummy 
library do not contain the actual program code, but rather the associated interfaces and inputs/
outputs. This means they are retained for the migration, after which they can be replaced with 
complete blocks of basic PLC program V6.x.

Requirement
• The basic program blocks are renamed (Page 70).

If the dummy blocks are copied before the basic program blocks have been renamed, the 
blocks are not replaced, but rather duplicated. In this case, the duplicate blocks must be 
deleted subsequently.

• The product DVD is inserted (or the "Support\Migration\SINUMERIK 840D sl Migration 
Dummy Library.zalXX" file is available elsewhere).

Procedure
To copy the library blocks to your project, proceed as follows:
1. In the "Options" menu, select the "Global libraries > Dearchive library" command.
2. Switch to the "Support\Migration" folder on the product DVD, select the "SINUMERIK 840D sl 

Migration Dummy Library.zalXX" file, and confirm with "Open".
3. If necessary, adapt the storage location in the "Search for folder" dialog and confirm with "OK".

As default, the new global libraries are stored in the following directory:
C:\Users\<user name>\Documents\Automatisierung\<library name>\<library name>.zalXX

4. Confirm the "Upgrade library" message with "OK".
5. Switch to the "Libraries" task card and open the "SINUMERIK 840D sl Migration Dummy 

Library_VXX" library.
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6. Drag-and-drop the "Copy Templates > Single Blocks" folder to the "Program Blocks" folder 
(e.g. at "CNC_1 > PLC_1 > Program Blocks").
The blocks are copied to your project. A check is made for duplicate block names, in which 
case the "Conflicts during copying" dialog is displayed.

7. Select the "Replace existing objects and move them to this location" option and confirm with 
"OK".

8. Right-click the "Program Blocks" folder and select the "Software (compile all blocks)" 
command.
The PLC program is compiled and a check is made for duplicate block addresses. Messages are 
issued if not all basic program blocks have been renamed.
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7.3 Converting a know-how protected block to a dummy block without 
function

Know-how protected blocks from other creators cannot be transferred with PLC migration, but 
rather the appropriate new blocks that can run on SINUMERIK ONE must be obtained from the 
creator.
If these blocks have been announced by the creator but are not yet available at the specified 
time, you can use the following workaround temporarily.
In this way, you can already migrate the other components and add the missing blocks later. The 
functionality of the missing blocks, however, is available only after adding the complete blocks.

Procedure
To convert a know-how protected block with PLC migration to a dummy block without function, 
proceed as follows:
1. In the "Program Blocks" folder, right-click the know-how protected block from which a 

dummy block is to be created, then select the "Copy as text" command.
The non-know-how protected part of the block (block name and parameters, and inputs/
outputs) is copied as program code to the clipboard.

2. With an external text editor (e.g. Notepad), add the content of the clipboard to the new file 
and save it as STL file. (The file name does not need to match the block name.)

3. In the "External Sources" folder, double-click "Add new external file", select the newly-created 
STL file and Confirm with "Open".

4. Right-click the newly added external source, and select the "Generate blocks from source" 
command.

Result
The know-how protected block in the "Program Blocks" folder is overwritten with a non-know-
how protected dummy block.
This block is now transferred during the PLC migration without causing any error messages, but 
does not have any function. Replace this dummy block with the correct or functional block once 
it is available from the associated manufacturer in a compatible version.
Make a note in your project documentation which blocks are dummy blocks and which still need 
to be augmented as functional blocks.
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7.4 Removing the Safety Integrated (SPL) program
Safety Integrated (SPL) is no longer supported by SINUMERIK ONE. If you have deployed this 
Safety operating mode, you must adapt the PLC program before the migration.

Basic procedure
Safety Integrated (SPL) blocks cannot be migrated to a SINUMERIK ONE.
• SI_Relais [FB10]
• SI_BrakeTest [FB11]
• SPL [DB18]

Note
Deleting the block causes compilation errors in the TIA Portal
Delete DB18 only after the PLC migration to SINUMERIK ONE (see Deleting blocks after the 
PLC migration (Page 82)).

• SI Pulse Teststop SL [FC264]
• SI External Stop SL [FC265]
If you have deployed this Safety operating mode, you must remove the associated blocks as well 
as all accesses to functions and function blocks, and to signals for data blocks from your PLC 
program.
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Migration of the SINUMERIK 840D sl program to a 
SINUMERIK ONE 8
8.1 Overview
Step Procedure
1 Migration of PLC program into a SINUMERIK ONE (Page 78)
2 Checking the migration log (Page 80)
3 Interconnect peripherals with SINUMERIK ONE (Page 83)
4 Checking the compilation messages (Page 85)
5 Transferring a telegram configuration (Page 86)
6 Preparing the conversion from FB4 to LBP_ReqPIService [FB7] (Page 90)

If you have deployed FB4 before the project migration and made adaptation steps there, complete them with this 
step.

7 Add data types of the basic PLC program blocks
8 Add dummy blocks to know-how protected basic program blocks (Page 97)
9 Convert DB2 to the PLC alarm extension (Page 103)

If you deploy the "ExtendAlMsg=False" DB2 variant, and migrate a SINUMERIK 840D sl project from a previously 
migrated TIA Portal, convert to the extended DB2 alarms here.

10 Converting accesses to the ZInfo0 DB2 array variable (Page 107)
If you have already deployed DB2 with alarm extension on the 840D sl, you may need to convert the calls of the 
ZInfo0 array variable.

11 Transfer user-defined alarm/message class configuration (Page 108)
If you have adapted the predefined alarm/message class configuration for DB2 alarms and converted to the ex‐
tended DB2 alarms in STEP 7 V5.5 SP4 or in the TIA Portal, transfer your user-defined alarm/message class con‐
figuration here.

12 Adapt or transfer the telegram configuration (Page 86)
If you deploy a user-defined telegram configuration, convert here either to the standard telegram configuration or 
transfer your user-defined I/O addresses to the SINUMERIK ONE.

13 Replacing the call of LBP_ConfigBP [FB1] in OB Startup [OB100] with LBP_ConfigBP [FC1] (Page 109)

See also
Supplementary conditions for calling LBP_NCKProcessIRT [FC3] in OB hardware interrupt [OB40] 
(Page 111)
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8.2 Migrate the PLC program to a SINUMERIK ONE (PLC migration)

Requirement
• The PLC program of the SINUMERIK 840D sl is compiled.

Procedure
To migrate the PLC program of a SINUMERIK 840D sl to a SINUMERIK ONE in the TIA Portal, 
proceed as follows:
1. Right-click the NCU and select the "Migrate to S7-1500" command.

The "Migrate to S7-1500" dialog opens.

2. Select the SINUMERIK ONE and confirm with "OK".
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3. Confirm the security warning "Check program after migration" with "OK".
The "PLC migration settings" dialog opens.

4. Select whether S7-300-PtP program blocks should be replaced automatically by the 
appropriate new S7-1500 operations and confirm with "OK".
The migration ends with a dialog from which the migration log can be called.

Result
The SINUMERIK ONE is added with default settings and the PLC program is migrated with its 
components. 
After migration, your project contains two NCUs, because the NCU1750 is created parallel to the 
7x0.
You can find the migrated components in the project navigation at SINUMERIK ONE (e.g. at 
"CNC_1 > PLC_1"):
• Program blocks of the SINUMERIK basic PLC program with user-specific adaptations or 

without know-how protection.
• Dummy blocks added for the migration
• Program blocks of the PLC user program whose creation language is supported by S7-1500, 

but do not have any know-how protection.
• PLC variable tables
• Monitoring and force tables
• PLC data types
• Technology objects
• User-defined groups in the project navigation
The hardware configuration of the SINUMERIK 840D sl is not transferred automatically.

Further information
• A comparison of the PtP communications operations of the S7-1500 and S7-300 PLCs can be 

found in the TIA Portal online help with the search term "Migration of PtP program blocks".
• Scope of migration (Page 32)
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8.3 Checking the migration log
The migration log, the messages from the compilation (Page 85) and the tables in 
the Appendix (Page 150) help you with assessing the migration result.
Because some problems can be rectified easier on the starting project, it can be desirable to 
discard a migration result, to edit the starting project and to migrate again.
Consequently, analyze the messages to get an overview of the migration result before investing 
unnecessary time in reworking the migration result.

Difference between errors and warnings
These messages are separated into errors and warnings. Errors must always be rectified so that 
the program can be compiled and can run. Warnings must be checked individually to determine 
whether they lead to problems.

Basic procedure
Consult the tables in the Appendix (Page 150) to determine in which step of the migration 
process an error can be rectified easiest:
• In the TIA Portal on the SINUMERIK 840D sl

In many cases, it can be desirable to discard a migration result, to rectify the errors in the PLC 
program of the SINUMERIK 840D sl shown in the migration log or during the compilation 
(Page 85), and to migrate again.

• After PLC migration to the SINUMERIK ONE
Some of the displayed problems can be rectified only after migration to a SINUMERIK ONE.

Displaying the migration log
The migration log is stored at the following location in the project navigation:
• "Common data > Logs"
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Use the log to check whether you can accept the migration result or you need to rectify the listed 
problems on the SINUMERIK 840D sl and migrate again.
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8.4 Deleting blocks after the PLC migration
Safety Integrated (SPL) is no longer supported by SINUMERIK ONE (see Chapter Removing the 
Safety Integrated (SPL) program (Page 76)). If you deploy the DB18 SPL block in your project, you 
must delete it after the PLC migration.

Basic procedure
If you have deployed this Safety operating mode, you must remove the DB18 SPL block as well 
as all accesses to functions and function blocks, and to signals for data blocks from your PLC 
program.
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8.5 Interconnect peripherals with SINUMERIK ONE
During the migration, the PLC program was added to the SINUMERIK ONE without copying the 
peripherals or interconnection. The peripherals can be interconnected with the SINUMERIK ONE.
If you duplicate the modules previously as described here, the old modules remain available in 
the project so they can be used as reference.

Note
Interconnecting NX modules with SINUMERIK ONE
NX modules of the SINUMERIK 840D sl cannot be interconnected with the SINUMERIK ONE or be 
converted to NX modules of the SINUMERIK ONE ("Replace device").
Add the new NX modules and interconnect them with the SINUMERIK ONE. 
Adapt settings, such as DP address or the telegram configuration, as needed.
See also: Standard telegram configuration of a SINUMERIK ONE (Page 153)

Requirement
• The PLC program of the SINUMERIK 840D sl is migrated to a SINUMERIK ONE.
• The peripherals should be reused unchanged or may already have been migrated 

individually.
Information about the migration of SIMATIC peripherals (such as ET200S to ET200SP) can be 
found in the online help of the TIA Portal with the search term "Migrating PLC programs to an 
S7-1500-CPU / ET200SP".

• Safety Integrated (F-PLC) is activated (Page 123).
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Procedure
To interconnect your peripherals with the SINUMERIK ONE, proceed as follows:
1. In the net view, select all peripherals, for example by dragging a selection rectangle around 

them.
2. Use the "Copy" and "Paste" commands.

The peripherals are pasted non-interconnected.

3. For each peripheral, click "Not assigned", then select the SINUMERIK ONE as master system.
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8.6 Checking the compilation messages

Basic procedure
Use the compilation messages and the tables in the Appendix (Page 150) to check whether you 
can accept the migration result or you need to rectify the listed problems for the starting project 
and migrate again.

Displaying compilation messages
When you compile the hardware and software, a check is made for further problems that 
possibly may not be listed in the migration log (Page 80). These messages are displayed in the 
"Info > Compile" inspector window.
1. In the project navigation, right-click the PLC and select the "Compile > Software (compile all)" 

or "Compile > Hardware (compile all)" command.
Problems can also be listed in the compilation messages that can be rectified easier in the 
starting project.
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8.7 Transferring a telegram configuration

8.7.1 Overview
The PLC migration does not include the automatic transfer of the telegram configuration of a 
SINUMERIK 840D sl (or NX modules).
The NCU 1750 newly-added during the PLC migration contains the standard telegram 
configuration of a SINUMERIK ONE that may differ (Page 153) somewhat from the standard 
telegram configuration of a SINUMERIK 840D sl.
The PLC migration, however, transfers the accesses to the telegram I/O addresses in the PLC 
program to the "PLC variables" editor without adapting the associated I/O addresses 
automatically.
You must make various adaptations appropriate for the telegram configuration of your starting 
system and of the desired configuration of the target system:

Telegram configuration 
of the starting system

Desired telegram configuration of the 
target system

Procedure

Standard telegram configuration of 
the SINUMERIK 840D sl

Standard telegram configuration of the 
SINUMERIK ONE (recommended)

Check the differences of the standard tele‐
gram configurations (Page 153) and make 
adaptations at the following places:
• Check the machine data and adapt to the 

new standard (Page 87)
• Check the I/O addresses of the migrated 

PLC variables and adapt the differences to 
the new standard (Page 87)

Standard telegram configuration of the 
SINUMERIK 840D sl (not recommended)

Enter the user-defined telegram configura‐
tion in the TIA Portal (Page 88)

User-defined telegram configuration User-defined telegram configuration
Standard telegram configuration of the 
SINUMERIK ONE

Check the differences of the standard tele‐
gram configurations (Page 153) and make 
adaptations at the following places:
• Check the machine data and adapt to the 

new standard (Page 87)
• Check the I/O addresses of the migrated 

PLC variables and adapt the differences to 
the new standard (Page 87)

See also
Activating Safety Integrated in the TIA Portal (Page 123)
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8.7.2 Adapting the I/O addresses in the machine data
If you want to use the standard telegram configuration on the SINUMERIK ONE, you must make 
some adaptations, because they differ from the standard telegram configuration of a SINUMERIK 
840D sl.

Requirement
• The machine data or the complete system are backed up in an archive so that after adapting 

the machine data for SINUMERIK ONE, a configuration that can run on SINUMERIK 840D sl is 
backed up.
Alternatively, you can perform this migration step even after the archive migration to the 
SINUMERIK ONE.

Procedure
To enter the I/O addresses of the optimized addressing schematic in the machine data, proceed 
as follows:
1. Call or print out the tabular overview of the standard I/O addresses with the associated 

machine data:
– Standard telegram configuration of a SINUMERIK ONE (Page 153)

2. Switch in SINUMERIK Operate to the general machine data via "MENU SELECT > 
Commissioning > Machine data > General MD".

3. Search for the associated machine data ("Search" softkey) and enter the I/O addresses (each 
for the deployed drives) in all cases where they deviate from the standard I/O address of the 
SINUMERIK ONE.

8.7.3 Adapting accesses to telegram I/O addresses in the user program (PLC 
variables)

The PLC migration transfers the accesses to the telegram I/O addresses in the PLC program to the 
"PLC variables" editor without adapting the associated I/O addresses automatically to the 
standard telegram configuration of the SINUMERIK ONE.
In some migration situations (Page 86), you must adapt the accesses to the telegram I/O 
addresses in your user program.

Basic procedure
To find and adapt the accesses to telegram I/O addresses, proceed as follows:
• Migrated PLC variables can be found in the "PLC variables" editor in the project navigation, 

e.g. at "CNC_1 > PLC_1 > PLC variables > Standard variable table".
• Those addresses that are not deployed can be checked in the Assignment plan that you can 

open from the associated context menu command.
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• PLC variables for telegram I/O addresses in the assignment plan are classified as "No hardware 
configured" and so yellow-highlighted.

Figure 8-1 Legend for highlighting in the assignment plan
• A tabular overview of the standard I/O addresses can be found in the Appendix (Page 153).

8.7.4 Transferring a user-defined telegram configuration
After the PLC migration, you can adapt the I/O addresses configured in the TIA Portal to your user-
defined I/O addresses. (To use a SINUMERIK ONE with the standard telegram configuration of a 
SINUMERIK 840D sl, also applies in this case as user-defined telegram configuration.)
If you want to adapt the I/O addresses in the TIA Portal, you should make this step only when you 
are sure that all other components have been migrated correctly.

Requirement
• The NX modules to be deployed are added (Page 83) to the configuration.
• Safety Integrated (F-PLC) is activated (Page 123) (provided this should be deployed).

Safety Integrated (F-PLC) must be activated before adapting the telegram I/O addresses, 
because telegrams 701 and 902 are added only when Safety mode is activated.

Entering user-defined I/O addresses in the TIA Portal
To adapt the I/O addresses of the telegrams used in the TIA Portal, proceed as follows:
1. Select the SINAMICS Integrated or NX and click "Cyclic data exchange" in the "Properties" 

inspector window.
2. Enter your user-defined start addresses in the "Partner data area" field of the individual 

telegrams.
To display the I/O addresses of the starting device and the new device concurrently, you can, 
for example, open two instances of the TIA Portal.

8.7.5 Reinserting additional telegrams after migration
Newly introduced telegrams as of V4.95, e.g. telegrams 1100 and 146, are configured in STEP 7 
Classic as "Additional telegrams PZD extension". During project migration of STEP 7 Classic 
projects with "Additional telegrams PZD extension", these are migrated and displayed as "Free 
telegrams" in the TIA Portal.
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After PLC migration and hardware replacement in SINUMERIK ONE (V6.15), the standard 
telegram configuration of a SINUMERIK ONE is always present and the "Additional telegrams PZD 
extension" previously configured in the STEP 7 Classic project are no longer displayed.
Reinsert any additional telegrams that are no longer available in the migrated TIA Portal project 
in accordance with the original project. These are, for example, telegrams 146 and 1100. 

Projekt-Migration

PLC-Migration

Figure 8-2 Additional telegram after project and PLC migration of a STEP 7 Classic project

How to reinsert additional telegrams after migration
Proceed as follows if you want to reinsert additional telegrams that are no longer present after 
the migration. The procedure is illustrated using telegram 1100 as an example.
1. Open the telegram configuration of SINAMICS Integrated.
2. Navigate to the drive object where the telegram is to be inserted.
3. Click on "Add telegram" and select telegram 1100.
4. Adjust the address range according to the source project. 

Figure 8-3 Adding a telegram using the example of telegram 1100
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8.8 Preparing the conversion from FB4 to LBP_ReqPIService [FB7]
The following adaptations are required only when you migrate your project from STEP 7 
V5.5 SP4 where the parameter transfer of the FB4 calls has already been adapted.
In this migration step, change the previously edited calls of the migration FB4 
"LBP_ReqPIService_MigFB4" to calls of the "LBP_ReqPIService [FB7]".

Requirement
• Parameter transfers for FB4 calls are converted to the extended FB7 interface (Page 62).
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Procedure
To complete the conversion of "LBP_ReqPIService_MigFB4 [FB4]" to "LBP_ReqPIService [FB7]", 
proceed as follows:
1. In the "Program Blocks" folder, right-click "LBP_ReqPIService_MigFB4 [FB4]" and select the 

"Cross-references" command.
2. Check the cross-reference list successively for all calls of the following types and edit them:

Type Procedure
Multi-in‐
stance

1. Check the cross-reference list for all hits that contain the "Data type" text and 
double-click the associated code.

2. Change each name of the data type from "LBP_ReqPIService_MigFB4" to "LBP_Re‐
qPIService".

Single-in‐
stance

1. Search in the cross-reference list for FB4 calls with single-instances and open 
them.

2. Change each name of the data type from "LBP_ReqPIService_MigFB4" to "LBP_Re‐
qPIService".

3. Right-click "LBP_ReqPIService" and select the "Change instance" command and 
confirm with "OK".

Note
Converting absolute accesses
If you also use absolute addressing, adapt here the block number of the instance DB created 
in the previous step:
1. First delete the superfluous instance DB of FB4.
2. Then in the project navigation, right-click the newly-created instance DB (from Step 2.3 

above) and open the properties.
3. Activate the "Manual" option at Number and enter the number used in the absolute 

accesses.
4. Confirm with "OK".

Note
Setting any unassigned mandatory parameters for programming in STL or SCL
In the SINUMERIK 840D sl environment, the FB4 input parameters "PIService" as well as 
"Addr1" to "Addr4" have the "ANY" type and consequently do not need to be initialized. In the 
SINUMERIK ONE, these input parameters have the "Variant" type in FB7. This causes the 
following compilation errors for the replacement of FB4 by FB7 in STL if the named input 
parameters were previously unassigned:
"The required operand at the input/output is missing or has an incorrect data type"
In the SCL environment, for example, the following compilation error results:
"Parameter 'Addr4' must be supplied."
Consequently, the unassigned "PIService", "Addr1", "Addr2", "Addr3" and "Addr4" input 
parameters must be assigned "NULL".

3. In the "Program Blocks" folder of the project navigation, right-click 
"LBP_ReqPIService_MigFB4 [FB4]", select the "Delete" command and confirm with "OK".
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8.9 Conversion from FB4 to LBP_ReqPIService [FB7] for the migration 
of the SINUMERIK 840D sl (TIA Portal)

The following adaptations are required only when you migrate your project starting at the TIA 
Portal. If you begun the migration in STEP 7 V5.5 SP4, the conversion from FB4 to FB7 was 
already made as shown in Chapters "Preparing the conversion from FB4 to LBP_ReqPIService 
[FB7] (Page 62)" and "Preparing the conversion from FB4 to LBP_ReqPIService [FB7] (Page 90)".
In this migration step, change the calls from PI_SERV [FB4] to calls of the "LBP_ReqPIService 
[FB7]".

Requirement
You begun the migration starting from a SINUMERIK 840D sl project in the TIA Portal.
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Procedure
To convert from "PI_SERV [FB4]" to "LBP_ReqPIService [FB7]", proceed as follows:
1. In the "Program Blocks" > "Single Blocks" folder, right-click "PI_SERV [FB4]" and select the 

"Cross-references" command.
2. Check the cross-reference list successively for all calls of the following types and edit them:

Type Procedure
Multi-in‐
stance

1. Check the cross-reference list for all hits that contain the "Data type" text and 
double-click the associated code.

2. Change each name of the data type from "PI_SERV" to "LBP_ReqPIService".
Single-in‐
stance

1. Search in the cross-reference list for FB4 calls with single-instances and open 
them.

2. Change each name of the data type from "PI_SERV" to "LBP_ReqPIService".
3. Right-click "LBP_ReqPIService" and select the "Change instance" command and 

confirm with "OK".

Note
Converting absolute accesses
If you also use absolute addressing, adapt here the block number of the instance DB created 
in the previous step:
1. First delete the superfluous instance DB of FB4.
2. Then in the project navigation, right-click the newly-created instance DB (from Step 2.3 

above) and open the properties.
3. Activate the "Manual" option at Number and enter the number used in the absolute 

accesses.
4. Confirm with "OK".

Note
Setting any unassigned mandatory parameters for programming in STL or SCL
In the SINUMERIK 840D sl environment, the FB4 input parameters "PIService" as well as 
"Addr1" to "Addr4" have the "ANY" type and consequently do not need to be initialized. In the 
SINUMERIK ONE, these input parameters have the "Variant" type in FB7. This causes the 
following compilation errors for the replacement of FB4 by FB7 in STL if the named input 
parameters were previously unassigned:
"The required operand at the input/output is missing or has an incorrect data type"
In the SCL environment, for example, the following compilation error results:
"Parameter 'Addr4' must be supplied."
Consequently, the unassigned "PIService", "Addr1", "Addr2", "Addr3" and "Addr4" input 
parameters must be assigned "NULL".

3. In the "Program Blocks" > "Single Blocks" folder of the project navigation, right-click "PI_SERV 
[FB4]", select the "Delete" command and confirm with "OK".
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8.10 Inserting PLC data types
The PLC interface data blocks of the basic program make it possible to access various interfaces 
and data from the PLC program (axes/spindles, channels, mode groups, alarms/messages, tool 
management, PLC/HMI, MCP/HT).
PLC data types (UDT), which define the content of the data blocks, are available in the system 
library of the SINUMERIK ONE PLC basic program. Copy these PLC data types into your project.

Procedure
Proceed as follows to copy the PLC data types into your project:
1. Switch to the "Libraries" task card and open the system library "SINUMERIK ONE PLC Basic 

Program V6.15"
2. Drag and drop the folder "Master copies > SINUMERIK ONE PLC Basic Program > SINUMERIK 

ONE PLC BP data types" into the folder PLC data types of your project (e.g. under "CNC_1 > 
PLC_1 > PLC data types").

Figure 8-4 Inserting PLC data types
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Result
The data types were copied into your project and assigned to the corresponding blocks of the PLC 
basic program.

Note
Deleting unused data types
Check the "PLC data types" folder, if applicable, for data types that are not used by the blocks. By 
inserting the SINUMERIK ONE PLC data types, for example, no (obsolete) data types of the 
SINUMERIK 840D sl are overwritten, since they have different names.
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8.11 Inserting the basic program blocks of the ONE library

8.11.1 Requirement
The block number ranges of the SINUMERIK basic PLC program in the project are not assigned 
blocks from other creators, e.g. user blocks, or third-party blocks or blocks from other Siemens 
products (e.g. DB_HMI [DB59] from Transline). The block number ranges of the SINUMERIK basic 
PLC program are shown in the tables in Appendix PLC basic program blocks (Page 129). 

Note
Procedure for the assignment of the SINUMERIK number range by blocks from other 
creators
Unlike the procedure for the complete transfer of the basic program blocks described later, you 
must transfer the required basic blocks individually from the library to your project, and so 
overwrite the previously added dummy blocks.

8.11.2 Procedure

8.11.2.1 Step 1: Add all blocks of the basic PLC program in Version 6.x
To add all blocks of the basic PLC program in Version 6.x, proceed as follows: 
1. Switch to the "Libraries" task card and open the "SINUMERIK ONE basic PLC 

program [Version]" system library.
2. Open the "Copy Templates > ONE basic PLC program (upgrade)" subfolder.

Note
"…(upgrade)" subfolder 
Use the "…(upgrade)" subfolder. This differs from the complete library by the absence of the 
DB75 (LBP_MFuncDecListConfig) and DB5 (LBP_ParamAlarmMsgs) data blocks. This prevents 
these two data blocks that may have customer-specific adaptations in the project to be 
migrated from being overwritten by SINUMERIK library blocks with default values.
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3. Drag-and-drop the "ONE PLC BP" copy template to the "Program Blocks" folder, e.g. at "CNC_1 
> PLC_1 > Program Blocks".
Note
Copying the "ONE PLC BP" folder overwrites any user blocks
If user blocks from the reserved number range of the SINUMERIK basic program are used in 
your project, you must not copy the complete folder. You must copy each required basic 
program block to prevent your own blocks from being overwritten. Caution: There are some 
mutual dependencies in the basic program (see Blocks of the PLC basic program that cannot 
be migrated (automatically) (Page 134)). 

The blocks are copied to your project. A check is made for duplicate block names, in which 
case the "Conflicts during copying" dialog is displayed.
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Note
Copying this folder changes the user-defined folder structure
Copying the "ONE PLC BP" folder automatically creates new groups (subfolders) in your 
"Program Blocks" folder and moves the existing blocks there.
If you have already organized the basic PLC program into separate groups and would like to 
keep this structure, copy the individual block copy templates from the lower-level folders 
instead.
(With the Ctrl or shift key, you can select several objects of the same type and then copy 
them.)

4. Select the "Replace existing objects and move them to this location" option and confirm with 
"OK".

8.11.2.2 Step 2: If required, add LBP_ParamAlarmMsgs[DB5] and 
LBP_MFuncDecListConfig[DB75]

The "ONE basic PLC program (upgrade)" directory was used to add know-how protected basic 
program blocks. The "LBP_ParamAlarmMsgs [DB5]" and "LBP_MFuncDecListConfig[DB75]" data 
blocks are missing in this directory. This prevents any customer-specific values in the original DB5 
or DB75 from being overwritten unintentionally. The new DB5 and DB75 are, however, required 
for the project to be compiled successfully. 
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If you have not changed DB5 or DB75 in your project, you must still copy the two blocks. To do 
this, proceed as follows:
1. Open the "Copy Templates > ONE basic PLC program" subfolder in the "SINUMERIK ONE basic 

PLC program V6.XX" system library.
2. Drag-and-drop the "LBP_ParamAlarmMsgs[DB5]" or "LBP_MFuncDecListConfig[DB75]" copy 

template to the appropriate "Program Blocks" subfolder.
3. Select the "Replace existing objects and move them to this location" option and confirm with 

"OK".

However, if you have made changes to DB5 or DB75 in your project, we suggest the following 
procedure:
1. Open the "Copy Templates > ONE basic PLC program" subfolder in the "SINUMERIK ONE basic 

PLC program V6.XX" system library.
2. Drag-and-drop the "LBP_ParamAlarmMsgs[DB5]" or "LBP_MFuncDecListConfig[DB75]" copy 

template to the appropriate "Program Blocks" subfolder.
3. Select the "Rename and add object" option in the "Conflicts during copying" dialog and 

confirm with "OK".
DB5 or DB75 is now twice in your project: "LBP_ParamAlarmMsgs[DB5]" and 
"LBP_ParamAlarmMsgs_1[DB5]" or "LBP_MFuncDecListConfig[DB75]" and 
"LBP_MFuncDecListConfig_1[DB75]".

4. In the project navigation, right-click "LBP_ParamAlarmMsgs[DB5]" or 
"LBP_MFuncDecListConfig[DB75]" and select the "Fast comparison" entry in the context 
menu.

5. Compare the two DB5 or DB75 blocks and make your changes in the new block.
6. Delete the associated old block and rename the new block by deleting the "_1" suffix in 

"LBP_ParamAlarmMsgs[DB5]" or "LBP_MFuncDecListConfig[DB75]" .

See also
Transferring a user-defined message class configuration (error message / operating message) 
(Page 108)
PLC basic program blocks (Page 129)

8.11.2.3 Step 3: Compile project
To compile the project, proceed as follows:
1. In the project navigation, right-click "Program blocks" and select the "Software (compile all 

blocks)" command in the "Compile" context menu.

See also
Transferring a user-defined message class configuration (error message / operating message) 
(Page 108)
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8.11.3 Result
The blocks of the basic SINUMERIK PLC program have been copied to your project. Whereby, the 
previously added dummy blocks were overwritten. The folder structure of the copy template was 
imported.

You can now check the copied blocks and manually delete the SINUMERIK PLC basic program 
blocks that you do not require (e.g. superfluous axis DB, channel DB, FB or FC).
If you have superfluous blocks in your project, they may affect the duration of some tasks, such 
as the loading of software into the device. Consequently, superfluous blocks should be deleted 
from the project. 
Superfluous blocks are identified with the "DummyLib" family. By displaying the program blocks 
in the list view, you can check whether there are still blocks that belong to the "DummyLib" 
family. The following variants are possible: 
• The required basic program blocks were not transferred from the library (e.g. when copying 

individual blocks).
• You have migrated blocks that are now no longer or not yet supported. 
Now compile the complete software of the project. 
The compilation may issue errors and warnings, e.g. for blocks and symbols that are no longer 
supported. Information about the rectification of errors and warnings can be found in Appendix 
Migration log and compilation messages (Page 150). 
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8.12 Adding data types - effects for the DB2 conversion in STEP 7 V5.5 
SP4

Result and effects for the conversion of the DB2 user concept of a STEP 7 V5.5 SP4 project
If you migrate starting with a STEP 7 V5.5 SP4 project, with completion of this step, the following 
adaptations have been made to DB2 signal accesses:
• With completion of this handling step, symbolic accesses to DB2 signals refer to the signal 

identifier of the extended LBP_AlarmMsgs [DB2] and the associated LBP_type_AlarmMsgs 
[UDT1002].

• Absolute accesses to DB2 signals remain as absolute accesses and refer to the offsets of the 
extended LBP_AlarmMsgs [DB2].

Note
If necessary, remove a migrated UDT2
If you have migrated a UDT2 from STEP 7 V5.5 SP4, it was not overwritten when new data types 
were added and it exists as UDT1002 and UDT2.
Delete the superfluous UDT2.

If you migrate starting with a TIA Portal project, make these adaptations first in Chapter 
Converting LBP_AlarmMsgs [DB2] to the PLC alarm extension (Page 103).
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8.13 Converting LBP_AlarmMsgs [DB2] to the PLC alarm extension
The following adaptations for converting the user alarm concept are required only when you 
have already migrated your SINUMERIK 840D sl PLC project and have worked in the meantime 
in the TIA Portal without converting the user alarm concept.
If you migrate to SINUMERIK ONE and do not want to work with a SINUMERIK 840D sl in the 
TIA Portal, convert the user alarm concept in STEP 7 V5.5 SP4 instead (Page 47).

Requirement
• The blocks of basic PLC program 6.x have been added.

See: Inserting the basic program blocks of the ONE library (Page 97), Inserting PLC data types
• DB5 exists or has been added from the SINUMERIK ONE library.

Overview
The steps to be performed in this chapter depend on which methods are used in your user 
program to access DB2:
• Direct access to DB2 with symbol signal identifiers (Page 103)
• Direct access to DB2 with absolute signal addresses (Page 105)
• Indirect access to DB2 using user DB and BLKMOVE operation (Page 104)
If, for example, you access DB2 sometimes symbolically and sometimes absolutely, you must 
make both adaptation steps.

8.13.1 Conversion for symbolic access to DB2 signals

Procedure
To adapt the symbolic accesses to DB2 in the TIA Portal (for the purpose of conversion to the user 
alarm concept "ExtendAlMsg=True"), proceed as follows:
1. Right-click the "Program Blocks" folder and select the "Search project" command.

The "Search project" editor opens and the search range is limited to the "Program Blocks" 
folder.

2. Enter "LBP_AlarmMsgs" in the "Search for" text field and confirm with "Start search".
3. Open the affected program locations successively and adapt the symbolic identifiers as 

described at Comparison of symbolic identifiers for DB2 signals (Page 145).
4. Right-click the "Program Blocks" folder and select the "Compile > Software (compile all 

blocks)" command.
The PLC program is compiled and a check is made for the correct symbolic addressing of the 
DB2 signals, etc.
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8.13.2 Conversion for indirect access via BLKMOV

8.13.2.1 Checking and adapting copied memory areas
The offset addresses of both DB2 variants have the same structure within the individual DB2 
areas1, each offset by a specific value. This offset is, however, different for each DB2 area.
Check whether you use BLKMOV copy operations that copy a memory area larger than a DB2 
area. If you copy such memory areas, you must divide the copy operation into several operations.
1See: "Area" column in the Comparison of offsets in DB2 variants (Page 144) table

Basic procedure
To divide the BLKMOV operations, proceed as follows:
1. The following options are available to find the affected locations in your user program:

– Right-click the "Program Blocks" folder and select the "Search project" command.
– Right-click "LBP_AlarmMsgs [DB2]" and select the "Cross-reference list" command.

2. Open those blocks with BLKMOV copy operations that copy the data of multiple DB2 areas 
concurrently (or copy a memory area larger than a DB2 area).

3. Divide the associated BLKMOV operations into several operations so that each copies the 
data of just one area.
The individual DB2/alarm number areas can be found at Comparison of the addresses in DB2 
(Page 144).

8.13.2.2 Adapting the copy target for BLKMOV
The offset addresses of both DB2 variants have the same structure within the individual DB2 
areas1, each offset by a specific value. This offset is, however, different for each DB2 area. 
Consequently, you must consider the new offset address appropriate for the associated DB2 area 
and adapt it appropriately.
1See: "Area" column in the Comparison of offsets in DB2 variants (Page 144) table
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Basic procedure
To adapt the target memory addresses for BLKMOV operations by copying the data to DB2, 
proceed as follows:
1. The following options are available to find the affected locations in your user program:

– Right-click the "Program Blocks" folder and select the "Search project" command.
– Right-click LBP_AlarmMsgs [DB2] and select the "Cross-reference list" command.

2. Open those blocks that copy data via BLKMOV to DB2.
3. Depending on whether the target memory area in DB2 is addressed absolutely or 

symbolically, proceed as follows:
– Absolute address: Change each offset address of the BLKMOV target memory area. The 

new offset address results from the sum of the previous address and the "offset".
A comparison of the associated offset addresses and the address offset can be found in 
the appropriate table (Page 144).

– Symbolic identifier: Adapt the symbolic identifiers as described at Comparison of symbolic 
identifiers for DB2 signals (Page 145).

8.13.3 Conversion for absolute access to DB2 signals

Procedure
To convert the access to absolute signals for DB2 in the TIA Portal, proceed as follows:
1. The following options are available to find the affected locations in your user program:

– Right-click the "Program Blocks" folder and select the "Search project" command.
– Right-click "LBP_AlarmMsgs [DB2]" and select the "Cross-reference list" command.

2. Open the affected program locations successively and convert the offset addresses of the 
associated DB2 signals. The new offset address results from the sum of the previous address 
and the "offset".
A comparison of the associated offset addresses and the address offset can be found in 
the appropriate table (Page 144).

8.13.4 Removing the user-defined numeric value parameter assignment of the 2nd 
user alarm decade

If you have adapted the 2nd digit (2nd decade of alarm number 7dx.xxx) user-defined in the user 
area (alarm numbers 7dx.xxx), you must remove these adaptations. SINUMERIK ONE does not 
support values that differ from the standard "0".
After the PLC migration to SINUMERIK ONE, any existing values for the "2nd decade" in 
LBP_ParamAlarmMsgs [DB5] have no effect. The existing DB5 array "UserDek2No [.]" in the 
SINUMERIK 840D sl basic PLC program has been renamed as "ByteArray72 [.]".
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Basic procedure
To remove the user-defined numeric value parameter assignment of the 2nd user alarm decade, 
proceed as follows:
• In LBP_ParamAlarmMsgs [DB5], set all values in LBP_ParamAlarmMsgs.ByteArray72[.] to 0.

Values that differ from the standard value 0 have no effect.
• If the PLC program writes these values with program operations (such as in OB100) in the 

LBP_ParamAlarmMsgs [DB5], these operations must be removed.
• In the TS files, change (with SINUMERIK Operate) the definition of the alarm texts for alarms 

7dx.xxx so that only alarm numbers 70x.xxx are used. To do this, search the TS files for entries 
with the element <source> and change the associated alarm number.
These changes must be made before you create the SINUMERIK 840D sl archive for the 
archive migration.

Further information 
Further information about specifying alarm texts can be found in the SINUMERIK Operate (IM9) 
Commissioning Manual at "Configuring alarms".
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8.14 Converting accesses to the ZInfo0 DB2 array variable
DB2 with alarm extension provides on 840D sl and also on ONE an array variable that contains 
an additional value for user alarms from user area 0:

 840D sl (≤ V4.9x) ONE (≥ V6.x)
Identifier ZInfo0 [0…63] AddValUserA0 [0…63]

Validity of the description
• If you convert from DB2 without alarm extension to DB2 with alarm extension, you do not 

need to make any additional adaptation, because AddValUserA0 or ZInfo0 is available only 
with the alarm extension.

• If you have already deployed DB2 with alarm extension on the 840D sl, you may need to 
convert the calls of the ZInfo0 array variable.

Procedure
To convert the accesses to ZInfo0 in the TIA Portal, proceed as follows:
1. Right-click the "Program Blocks" folder and select the "Search project" command.

The "Search project" editor opens and the search range is limited to the "Program Blocks" 
folder.

2. Enter "LBP_AlarmMsgs" in the "Search for" text field and confirm with "Start search".
Note
Alternatively, you can call the "Cross-references" command in the context menu for 
LBP_AlarmMsgs [DB2].

3. Open the affected program locations successively and change ZInfo0 to AddValUserA0.
4. Right-click the "Program Blocks" folder and select the "Compile > Software (compile all 

blocks)" command.
The PLC program is compiled and a check is made for the correct symbolic addressing of the 
DB2 signals, etc.
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8.15 Transferring a user-defined message class configuration (error 
message / operating message)

If you have adapted the predefined alarm/message class configuration for DB2 alarms, you must 
transfer your adaptations. The migration step is required only when you use a configuration that 
differs from the standard, i.e. different criteria for differentiating error messages (ErrM: Error 
Messages) and operating messages (OpM: Operating Messages).
A user-defined adaptation of DB2 alarm/message classes depending on the deployed DB2 
variant is contained in the following blocks:
• DB2 variant "ExtendAlMsg = False": Adaptation of the configuration in DB4, OB100 or in a 

user FB/FC
Any contained or migrated accesses to the explicit initialization of DB4.BOfeld0… 
DB4.BOfeld61 (Word), DB4.BOfeld62 (Byte) as well as DB4 are part of the DB2 alarm concept 
without alarm extension in your user program for the SINUMERIK 840D sl.
SINUMERIK ONE no longer supports this. Consequently, adapt your user program 
accordingly.

• DB2 variant "ExtendAlMsg = True": Adaptation of the configuration in DB5, OB100 or in a user 
FB/FC

We recommend that the user-defined configuration adaptation is entered indirectly via a user FB/
FC in the LBP_ParamAlarmMsgs [DB5], rather than directly in DB5 (via the DB editor). User FB/FCs 
can be transferred easier if you need to upgrade the basic PLC program later.

Assignment between configuration bit and 8-fold group of trigger bits
Each alarm/message class can be defined for a group of 8 alarms that can be triggered via trigger 
bits in LBP_AlarmMsgs [DB2]:
• Error message (configuration bit in LBP_ParamAlarmMsgs [DB5]:= TRUE)
• Operating message (configuration bit in LBP_ParamAlarmMsgs [DB5]:= FALSE)
Whereby, the following assignment between configuration bit and 8-fold group of trigger bits 
can be used as example:

 

 

 

 

… … 

  

… … 

 

)490(%DB2.DBB

AAFdStop60AAxx[0..7]].1[isAAxLBP_AlarmMsgs.

(%DB5.DBX22.4)

490_DB2_Ax1LBP_ParamAlarmMsgs.

)312(%DB2.DBB
[0..7]01xxCFDD_RID_5].1[anAChLBP_AlarmMsgs.

(%DB5.DBX0.2)

312_DB2_Ch1amAlarmMsgs.LBP_Par

)311(%DB2.DBB
[8..15]00xxCFDD_5].1[anAChLBP_AlarmMsgs.

(%DB5.DBX0.1)

311_DB2_Ch1LBP_ParamAlarmMsgs.

)310(%DB2.DBB
[0..7]00xxCFDD_5].1[anAChLBP_AlarmMsgs.

(%DB5.DBX0.0)

310_DB2_Ch1LBP_ParamAlarmMsgs.

The alarms of the associated alarm group so trigger error messages or operating messages in 
accordance with the configuration.
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8.16 Replacing the call of LBP_ConfigBP [FB1] in OB Startup [OB100] 
with LBP_ConfigBP [FC1]

In the SINUMERIK ONE, LBP_ConfigBP [FB1] was replaced with LBP_ConfigBP [FC1]. 
Consequently, after the PLC migration, the call of LBP_ConfigBP [FB1] in OB Startup [OB100] 
must be replaced manually with the call of LBP_ConfigBP [FC1].

Procedure
To replace in the TIA Portal, the call of LBP_ConfigBP [FB1] in OB Startup [OB100] with 
LBP_ConfigBP [FC1], proceed as follows:
1. Open the OB Startup [OB100] for editing.
2. Navigate in the "Program Blocks" folder of the project navigation to the LBP_ConfigBP [FC1] 

(e.g. at "CNC_1 > PLC_1 > Program Blocks > ONE PLC BP > FC").
3. Drag-and-drop "LBP_ConfigBP [FC1]" to the editing area of the OB Startup [OB100]. This 

implements the LBP_ConfigBP [FC1] call with pre-assigned actual parameters.

4. Change those parameters that differ from the default values.
5. If you want to transfer PLC machine data in your project, you have stored the CPU-DB DB20, 

created in the SINUMERIK 840Dsl environment, already as global DB in an earlier migration 
step (see "Add global DB or DB based on UDT for further blocks (Page 56)"). You must now link 
the new "UserDataIntArray", "UserDataHexArray" and "UserDataRealArray" parameters with 
the associated arrays in DB20. 
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Further information
Further information on handling PLC machine data can be found in the SINUMERIK ONE PLC 
Function Manual under the keyword "PLC machine data" in Chapter "LBP_ConfigBP [FC1]"

See also
FB1 and FC1 comparison (Page 139)
Comparison of symbolic identifiers for DB7  (Page 147)
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8.17 Supplementary conditions for calling LBP_NCKProcessIRT [FC3] in 
OB hardware interrupt [OB40]

The LBP_NCKProcessIRT [FC3] interface has been extended with the "Flags" output parameter of 
the Variant type. The output parameter must be assigned NULL in the current SINUMERIK ONE. 
This is performed with compilation automatically during migration. The local data 
GP_IRFromNCK, GP_TM, GP_InPosition, GP_AuxFunction and GP_FMBlock also migrated are no 
longer supported.
Alternatively, a temporary variable, e.g. with the name "GP" of type 
"LBP_typeNCKProcessIRTFlags", can be created and transferred to the Flags output parameter. 
Upon calling FC3, the following data is then returned which corresponds to the previous OB40 
local data: GP.IRFromNCK, GP.TM, GP.InPosition and GP.AuxFunction. There is no equivalent to 
GP_FMBlock. This local data, however, has not been filled previously and has therefore been 
deleted with no replacement. 

Migration of the SINUMERIK 840D sl program to a SINUMERIK ONE
8.17 Supplementary conditions for calling LBP_NCKProcessIRT [FC3] in OB hardware interrupt [OB40]

Migration to a SINUMERIK ONE
System Manual, 07/2021, A5E47495977B AD 111



8.18 FB9 Implementing an MCP switchover in the user program
An MCP is no longer switched over with the PLC block FB9. This block is no longer part of the basic 
program library V6.x. The MCP must be switched over in the user program.

User program as replacement for FB9
To switch over the MCP in the user program, proceed as follows.
1. In OB100 (call of FC1), set "LBP_ConfigData".MCP1BusAdr to 255 and 

"LBP_ConfigData".MCP1Stop to "TRUE".
2. Query the signal "LBP_NC".E_MMCBTSSready in OB1.
3. Once the signal has been set, write the MCP address from "LBP_HMI".MMC1_MSTT_ADR to 

"LBP_ConfigData".MCP1BusAdr and delete the MCP stop bit "LBP_ConfigData".MCP1Stop.
The MCP is now active.

4. If the signal "MMCBTSSready" is deleted again (operating software switches to another NCU), 
you must set the MCP stop bit "LBP_ConfigData".MCP1Stop again.

Symbol Absolute address
"LBP_NC".E_MMCBTSSready DB10.DBX108.3
"LBP_HMI".MMC1_MSTT_ADR DB19.DBB123
"LBP_ConfigData".MCP1BusAdr DB7.DBW26
"LBP_ConfigData".MCP1Stop DB7.DBX62.1
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8.19 Adapting the use of ProcEventDispl in channel DBs
In the SINUMERIK 840D sl environment, byte 376 in the channel DBs (DB21 to DB30) has the 
"ProcEventDispl" symbol. In the SINUMERIK ONE, the symbolism has changed so that the 
individual bits in byte 376 each have their own symbol appropriate for their meaning. The 
following table illustrates this situation.

840D sl UDT21 byte 376 ONE LBP_typeChanX Byte376
ProcEventDispl
 
 
 
 
 
 
 

376.0 E_ProgEvent_Start
376.1 E_ProgEvent_M30
376.2 E_ProgEvent_Reset
376.3 E_ProgEvent_PowerOn
376.4 E_ProcEvent_SearchRun
376.5 E_ProgEvent_Safety
376.6 f376_6 (reserved)
376.7 f376_7 (reserved)

If the "ProcEventDispl" symbol was used in the SINUMERIK 840D sl, this causes a compiler 
warning after the PLC migration because this symbol no longer exists.
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① Byte access without symbol
② Use of the SINUMERIK ONE symbols
③ Alarm

Figure 8-5 DBB376: Byte access without symbol causes a compiler warning after the PLC migration
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8.20 Substituting the functionality of FC22 (TM_DIR in 840Dsl)
FC22 is no longer available in the library for SINUMERIK ONE. Referred to the location numbers, 
e.g. of a tool magazine or turret, this block supplied the shortest path and direction of motion 
for positioning, based on the target and current position. If you used the FC22 in your 
SINUMERIK 840D sl program, you must emulate its function in the user program of SINUMERIK 
ONE.

User program output parameters
The following overview demonstrates how you can define the new output parameters for the 
user program from the existing input parameters of FC22:

Signal Meaning New meaning of the user program
MagNo: Magazine number Specify the number of magazine locations NumOfPlaces 

of the magazine to be used instead of the magazine 
number MagNo.

ReqPos: Target position -
ActPos: Current position -
Offset: Offset for special positioning -
Start: 1 = start of calculation -

Determining the output parameters
• If offset is > 0, recalculate ReqPos first.

– ReqPos = ((ReqPos + NumOfPlaces – Offset) MODULO NumOfPlaces)
– The new target position corresponds to the location number at which the magazine must 

be positioned so that the original target position is at the location number of the special 
position.

• Cw: Move magazine clockwise = TRUE
– If ReqPos > ActPos and the absolute difference between ReqPos and ActPos is less than or 

equal to half the number of magazine locations.
Or

– If ReqPos < ActPos and the absolute difference between ReqPos and ActPos is greater than 
half the number of magazine locations.

• Ccw: Move magazine counterclockwise = TRUE
– If Cw = FALSE and ReqPos <> ActPos.

• InPos: Position reached = TRUE
– If ReqPos = ActPos.

• Diff: Value of differential movement = Abs(ReqPos – ActPos) or NumOfPlaces - Abs(ReqPos – 
ActPos)
– If the absolute difference between ReqPos and ActPos is greater than half the number of 

magazine locations.
– Error: If the offset is greater than the number of magazine locations (NumOfPlaces), Error 

= TRUE must be issued. The other output parameters are then invalid.
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8.21 Magazine data from DB4 in the PLC program

Using magazine data in the PLC program
The DB4 is no longer part of the basic program library and is no longer evaluated. Configuration 
of the magazine is now only performed in the NC. If the magazine configuration is required in 
the PLC user program, the magazine data can be called when calling "LBP_ConfigBP [FC1]" . 
Create a variable or a data block of the type "LBP_typeTMMagazines".

Examples
Information of the magazine configuration is used in the PLC program

// tempMagazineData: "LBP_typeTMMagazines"
 "LBP_ConfigBP"(…,  
  TMMagazines => #tempMagazineData);

Information of the magazine configuration is not used in the PLC program
If no information regarding magazine configuration is required in the PLC user program, the 
output parameter at the "LBP_ConfigBP [FC1]" can be allocated with ZERO.

 "LBP_ConfigBP"(…,  
  TMMagazines => NULL);

See also
Migratable blocks of the PLC basic program (Page 129)
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8.22 Integrating Powerride LBP_Powerride [FB21]
The function block FB21 "Powerride" integrates a rotary/push control dial (SINUMERIK 
Powerride) into the SINUMERIK environment. After the PLC migration, the "Powerride [FB21]" 
(new from V4.94) must be adapted to the "FB LBP_Powerride [FB21]" (new from V6.14).

Procedure
To customize the FB calls in TIA Portal, proceed as follows:
1. Update all calls, since the interface has changed for SINUMERIK ONE (no use of statusId).

– Click on the call.
– Select "Update" from the shortcut menu.

2. Change the data type from BYTE to USINT for the following parameters:
– pushButtonLED
– presetValue
– ovrFactor
– grayCode
– switchPos

3. Change the type of the following parameters:
– deviceIn, LBP_typePowerrideInput 
– deviceOut, LBP_typePowerrideOutput

4. Migrate the UDTs used (see table below). 

Migration of the used UDTs UDT80 - UDT91
If you use the UDTs UDT80 - UDT91, replace the UDTs according to the following table.

UDT Type old Type new
UDT80 TypePowerrideIn LBP_typePowerrideInput
UDT81 TypePowerrideOut LBP_typePowerrideOutput
UDT82 TypeModMcpAxisIn LBP_typeModularMcpAxisInput
UDT83 TypeModMcpAxisOut LBP_typeModularMcpAxisOutput
UDT84 TypeModMcpBaseIn LBP_typeModularMcpBaseInput
UDT85 TypeModMcpBaseOut LBP_typeModularMcpBaseOutput
UDT86 TypeModMcpKeypadRecord LBP_typeModularMcpKeypadRecord
UDT87 TypeModMcpLedAttribute LBP_typeModularMcpLedAttribute
UDT88 TypeModMcpModeGroupIn LBP_typeModularMcpModeGroupInput
UDT89 TypeModMcpModeGroupOut LBP_typeModularMcpModeGroupOutput
UDT90 TypeModMcpUniversalIn LBP_typeModularMcpUniversalInput
UDT91 TypeModMcpUniversalOut LBP_typeModularMcpUniversalOutput
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8.23 Operator component communication via Ethernet 
LBP_OpUnitComm [FB25000] 

The new "LBP_OpUnitComm [FB25000]" block is used in SINUMERIK ONE for communication 
with machine control panels (MCP), handheld terminals (HT), and direct key modules (OpKey) 
via Industrial Ethernet (IE). For migrated projects, you must consider this block in your PLC user 
program.

Note
This function is not available in the virtual SINUMERIK.
The parameters are assigned at the FC1 as an Ethernet machine control panel with inputs from 
bit E0.0 and outputs from bit A0.0 (also possible symbolically via variable table).

Function
The parameters for the configuration can be set in the startup OB (e.g. "Startup [OB100]") via 
"LBP_ConfigBP [FC1]". Additional factors or a changed configuration of the connections can be 
set in the cycle via the parameters in "LBP_ConfigData [DB7]".
"LBP_OpUnitComm [FB25000]" should be called in the PLC cycle before calling 
LBP_MCPCtrlMilling [FC19], LBP_MCPCtrlMillingSmall [FC24], LBP_MCPCtrlTurning [FC25], 
LBP_HTCtrlHT8 [FC26] and LBP_HTCtrlHT2 [FC13] or before accessing input data, for example, 
after calling LBP_MainBP [FC2]. This means that actual operator component data is available for 
subsequent program parts.

More information
Further information regarding the use and programming of "LBP_OpUnitComm [FB25000]" can 
be found in the SINUMERIK ONE PLC Function Manual.
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8.24 Write data record to MCP LBP_OpUnitWriteRecord [FB25002] 
The block writes a data record to a modular MCP.  After the PLC migration, the 
"OpUnitWriteRecord [FC27]" (new from V4.94) must be adapted to the "LBP_OpUnitWriteRecord 
[FB25002]" (new from V6.14).

Procedure
To customize the FB calls in TIA Portal, proceed as follows:
1. Replace all obsolete calls in the user program with the new "LBP_OpUnitWriteRecord 

[FB25002]". The calls are normally only contained in the cyclic part of the user program.
2. Transfer the values of the previous parameters to the new FB.
3. Create an instance DB for "LBP_OpUnitComm [FB25000]" in the project.
4. Change the type of the following parameters from WORD to UINT.

– MCPNum
– SlotnUM
– RecNum

5. Create an instance DB in the project for "LBP_OpUnitWriteRecord [FB25002]" (FC27 becomes 
FB25002).
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8.25 Use of the "VARIANT" data type in the blocks of the basic program 
library

In the SINUMERIK ONE library, the use of the "ANY" data type has been replaced with the new 
"VARIANT" data type available for S7-1500 PLCs. This affects the FB2, FB3, FB5 and FB7 function 
blocks as well as the FC21 function.
A significant advantage of the "VARIANT" data type is that data in optimized DBs can also be 
accessed. The availability of several new language elements for handling the "VARIANT" data 
type also simplifies the programming and is less error-prone.
"ANY" parameters do not need to be initialized, i.e. no value needs to be specified when calling 
a function block with "ANY" parameters. In the SINUMERIK 840D sl environment, the current 
value from the associated instance DB (which can also match the initial value) is used for 
uninitialized "ANY" parameters. 
For the migration of the mentioned blocks, uninitialized previous "ANY" parameters are replaced 
automatically with the appropriate "VARIANT" parameter and initialized with "NULL". If this is not 
desired, the affected function calls must be adapted manually.
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8.26 Completing the migration
To complete the migration, check whether all blocks have been converted and your project can 
be compiled.
In the Detail view of all program blocks (Page 71), search for all blocks of the "DummyLib" family. 
Such blocks are no longer supported. This affects, for example, the blocks FB29, FC5, FC22, 
FC1005, FC1006, ... .
First check where these blocks are used and remove their use. Then delete the blocks.

See also
Renaming basic program blocks (Page 70)
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Converting the safety functionality 9
9.1 Activating Safety Integrated in the TIA Portal

Procedure
Proceed as follows to activate Safety Integrated (F-PLC):
1. Click the NCU in the network or device view and select the "Safety Integrated" entry in the 

"Properties > General" inspector window.
2. Click the "Change Safety Integrated mode" button.

The "Change Safety Integrated mode" dialog opens. If you select an option, the effects of the 
mode change are performed here.

3. Select "SINUMERIK Safety Integrated (F-PLC)" and confirm the reconfiguration with "Yes".

Result
The Safety Integrated mode has been changed. The precise effects can be seen in the "Change 
Safety Integrated mode" dialog (step 2).
If problems occur during the changeover, you can find more information in the "Info > General" 
inspector window.

Note
Effects on telegram configuration
The Safety Integrated mode used affects the telegram configuration because, in the Safety 
Integrated (F-PLC) mode, different telegrams are used than when the Safety Integrated mode is 
inactive.
Telegrams that are added or changed are kept, however, as long as they are compatible with the 
newly selected Safety Integrated mode.
Make sure, if applicable, that any modifications are still present following the change of mode 
in the telegram configuration (Page 153).

As long as you have not saved the project, you can completely undo the change of the Safety 
Integrated mode by clicking "Undo" in the toolbar.
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9.2 Licensing of axes/spindles and F-PLC
To use Safety Integrated, you require in addition to the license for SIMATIC STEP 7 Safety 
Advanced (TIA Portal), the appropriate software options for the RT function: 

Table 9-1 Software options when using Safety Integrated 
Software option Article No. Purpose
SINUMERIK ONE Safety 
Integrated - F-PLC 

6FC5800-0BS60-0YB0 Activate the F-PLC in the SINUMERIK control system 
to process the failsafe sensors and actuators in an F-
program.

SINUMERIK ONE Safety 
Integrated - axis/spin‐
dle 

6FC5800-0BK00-0YB0 Use the motion control functions of the SINAMICS 
Integrated in the "SINUMERIK Safety Integrated (F-
PLC)" mode.
License for 1 axis/spindle, multiple licensing in or‐
der to be able to use additional axes/spindles.

SINUMERIK ONE Safety 
Integrated - multi axis 
packet 

6FC5800-0BS61-0YB0 Use the motion control functions of the SINAMICS 
Integrated in the "SINUMERIK Safety Integrated (F-
PLC)" mode.
License for any number of axes/spindles.

Depending on the functions used, you must license the appropriate software options and set in 
the machine data:
• MD19500 $MN_SAFE_PLC_LOGIC: Safety Integrated basic option - F-PLC 
• MD19121 $MN_NUM_DRIVEBASED_SAFE_AXES: Number of axes/spindles in the 

"SINUMERIK Safety Integrated (F-PLC)" mode

Additional licensing information: 
You can find additional information about licensing in: 
SINUMERIK ONE Commissioning Manual: Work steps for configuring and commissioning
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9.3 Transition of Safety Integrated (SPL) to Safety Integrated (F-PLC)

9.3.1 Creating a safety program

Requirement
• Access to DB18 signals and to PLC-SPL code has been removed from the PLC program.
• The migration of the standard PLC program to a SINUMERIK ONE has been completed.

Basic procedure
The transfer or migration of a Safety Integrated (SPL) program to a Safety Integrated (F-PLC) 
safety program is not possible, because not only the program code, but also the locations or 
blocks from which the safety program can be called, differ greatly.
To use Safety Integrated (F-PLC), you must create a new safety program based on your existing 
safety concept or the risk analysis.
Programming of the safety program of Safety Integrated (F-PLC) for SINUMERIK ONE and of 
SINUMERIK Safety Integrated plus for the SINUMERIK 840D sl is comparable.

Further information 
• SIMATIC Safety Advanced System Manual
• SINUMERIK ONE Safety Integrated Commissioning Manual
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9.4 Adaptations to the safety program for migration from 840D sl to 
SINUMERIK ONE

9.4.1 Checking the calls of a migrated F-runtime group
In Safety Integrated (F-PLC) mode, a SINUMERIK ONE differs from a SINUMERIK 840D sl for the 
use of F-runtime groups.
Consequently, the calls of the F-runtime group of a SINUMERIK 840D sl are not migrated 
automatically. Check your PLC program or safety program for such calls and convert them to the 
new F-runtime group of the SINUMERIK ONE.
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Completion of the migration and more detailed 
information 10

The migration of the PLC is completed with the previous work steps. 
In a further step, the HMI, NCK and drives must still be commissioned. 

Further information
You can find information on the following topics in the SINUMERIK ONE documentation 
overview (Page 9).
• Using and handling machine projects 
• Archives in SINUMERIK Operate
• Safety functionality
• Upgrade
• Work steps for configuring and commissioning
• Functions
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Appendix A A
A.1 PLC basic program blocks

A.1.1 Migratable blocks of the PLC basic program
All blocks of the SINUMERIK basic PLC program transferred automatically during the PLC 
migration are listed below. Except for the following blocks, the migrated blocks after minor 
adaptations (such as changing symbolic names) are compatible with the basic PLC program 
V6.x: DB4 [DB4], DB15 [DB15], SPL [DB18], DB77 [DB77] and ALMSG_DB [DB2] in the variant 
"ExtendAlMsg=False". Although these blocks are transferred during the PLC migration, they are 
no longer part of the basic program. Accesses to these blocks must be deleted or possibly 
replaced with other blocks or operations.

Table A-1 Migratable data blocks (DB)
Address Symbol in basic PLC program version Remark

Up to V4.9x As of V6.x (SINUMERIK ONE)
DB2 ALMSG_DB -- Variant without alarm extension 

Can be migrated to SINUMERIK ONE, but is no lon‐
ger supported in this variant. See: User alarm con‐
cept (DB2) (Page 35)

DB2 ALMSG_DB LBP_AlarmMsgs Variant with alarm extension (1062 bytes or max. 
6016 DB2 alarms)
Interface between user program and LBP_GenA‐
larmMsgs [FC10], contains bit arrays for blocking 
and stop signals as well as error and operating 
messages.
See also: Interface DB of the PLC basic program 
(Page 142)

DB4 DB4 -- Can be migrated to SINUMERIK ONE, but the block 
is no longer supported and any user-defined adap‐
tations must be transferred. See also: Transferring 
a user-defined message class configuration (error 
message / operating message) (Page 108), User 
alarm concept (DB2) (Page 35)
The configuration data for tool management is no 
longer needed in this block. The basic PLC program 
receives this data via the internal NCK-PLC inter‐
face.
See also: Magazine data from DB4 in the PLC pro‐
gram (Page 116)
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Address Symbol in basic PLC program version Remark
Up to V4.9x As of V6.x (SINUMERIK ONE)

DB5 DB5 LBP_ParamAlarmMsgs Interface between user program and LBP_GenA‐
larmMsgs [FC10], contains the parameter assign‐
ment of the alarms for the bit fields in the 
LBP_AlarmMsgs [DB2] as error or operating mes‐
sage.

DB7 gp_par LBP_ConfigData As of V6.x, DB7 is a global DB. Except for some su‐
perfluous variables, it is compatible with the old 
instance DB. Contains parameters for the configu‐
ration and initialization of the basic program. See 
also: Comparison of symbolic identifiers for DB7  
(Page 147)

DB8 DB8 LBP_InternalDB8 DB only for internal use in the basic program.
DB9 DB9 -- PLC compile cycles, the block is not part of basic PLC 

program V6.x or higher
DB10 NC LBP_NC Interface between user program and NC, contains 

signals from/to the NC, PLC and operating software.
See also: Interface DB of the PLC basic program 
(Page 142)
Restriction
The offsets E_MCP1ready, E_MCP2ready, 
E_HTready, E_OP1KeyReady and E_OP2KeyReady 
(DBX104.0 … DBX104.4) are only supplied for IE 
MCPs, but not for PN MCPs.
HT and direct keys (OpKey) can generally only be 
connected via Ethernet.
The diagnostic signals in byte 92 are not yet avail‐
able. Information in this regard can be obtained in 
the TIA Portal help system using the keyword "Mi‐
gration of RDSYSST operation".

DB11 Mode group LBP_ModeGroup Interface between user program and mode groups, 
contains signals from/to the NC and operating soft‐
ware.
See also: Interface DB of the PLC basic program 
(Page 142)

DB15 DB15 -- General communication
As of V6.x, the block is no longer part of the basic 
PLC program.

DB16 PI LBP_PIServices Interface for LBP_ReqPIService [FB7], contains def‐
initions for all available PI services.

DB17 DB17 -- For identification of the control type. 
The block is no longer part of the basic PLC program 
as of V6.x 

DB18 SPL -- Safety Integrated data (SPL)
Although transferred for the migration to SINU‐
MERIK ONE, Safety Integrated (SPL) is no longer 
supported.
See: Converting the safety functionality (Page 123)
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Address Symbol in basic PLC program version Remark
Up to V4.9x As of V6.x (SINUMERIK ONE)

DB19 MMC LBP_HMI Interface between user program and operator pan‐
el, contains signals from/to the operating software.
See also: Interface DB of the PLC basic program 
(Page 142)

DB20 -- -- See also: Global DB or DB based on UDT (Page 56)
DB21...DB30 Chan1…Chan10 LBP_Chan1…LBP_Chan10 Interface between user program and channel, con‐

tains signals from/to the channel.
See also: Interface DB of the PLC basic program 
(Page 142)

DB31...DB61 Axis1...Axis31 LBP_Axis1...LBP_Axis31 Interface between user program and axis/spindle, 
contains signals from/to axis/spindle.
See also: Interface DB of the PLC basic program 
(Page 142)

DB71 TMLoadIF LBP_TMLoad Interface between user program and tool manage‐
ment, contains signals from/to Load/Unload maga‐
zine.
See also: Interface DB of the PLC basic program 
(Page 142)

DB72 TMSpindleIF LBP_TMSpindle Interface between user program and tool manage‐
ment, contains signals for spindle as change posi‐
tion.
See also: Interface DB of the PLC basic program 
(Page 142)

DB73 TMRevIF LBP_TMTurret Interface between user program and tool manage‐
ment, contains signals for turret.
See also: Interface DB of the PLC basic program 
(Page 142)

DB74 -- -- The block is no longer part of the basic PLC program 
as of V6.x. Internal block which does not have to be 
migrated.

DB75 DB_MDec_List LBP_MFuncDecListConfig Decoding list for M decoding according to the list. 
Can be migrated to SINUMERIK ONE.

DB76 DB_M_Funktionen LBP_MFuncDecListSignals Signal list for M decoding according to the list. Can 
be migrated to SINUMERIK ONE.

DB77 DB77 -- Although transferred for the migration to SINU‐
MERIK ONE, as of V6.x, DB77 is no longer part of the 
basic PLC program and is no longer supported.

DB78 PowerrideConfig LBP_PowerrideConfig Global data block containing two example config‐
urations for a Powerride rotary/push switch using 
UDT78 and UDT79. See also: Integrating Powerride 
(Page 117)

DB1000 CtrlE LBP_CtrlEnergy Interface between user program and operating 
software, contains energy saving profiles for Ctrl-
Energy.
Not yet supported in V6.15.
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Address Symbol in basic PLC program version Remark
Up to V4.9x As of V6.x (SINUMERIK ONE)

DB1001 SentronPac LBP_SentronPac Interface between user program and operating 
software, contains signals for SENTRON PAC ener‐
gy monitoring devices.
Not yet supported in V6.15.

DB1002 ISM_TS LBP_SpindleTempSensor Interface between user program and operating 
software, contains signals for spindle temperature 
sensors.
Not yet supported in V6.15.

DB1071 TMLoadIF_MT LBP_TMLoadMT Interface between user program and tool manage‐
ment, contains signals to Load/Unload magazine 
(multitool).
See also: Interface DB of the PLC basic program 
(Page 142)

DB1072 TMSpindleIF_MT LBP_TMSpindleMT Interface between user program and tool manage‐
ment, contains signals for spindle as change posi‐
tion (multitool).
See also: Interface DB of the PLC basic program 
(Page 142)

DB1073 TMRevIF_MT LBP_TMTurretMT Interface between user program and tool manage‐
ment, contains signals for turret (multitool).
See also: Interface DB of the PLC basic program 
(Page 142)

Table A-2 Migratable organization blocks (OB)
Address Symbol in basic PLC program version Meaning

Up to V4.9x As of V6.x (SINUMERIK ONE)
OB1 OB1 Main Cyclic execution
OB40 OB40 Hardware interrupt Hardware interrupt
OB82 OB82 Diagnostic error interrupt Asynchronous error: Diagnostics alarm
OB86 OB86 Rack or station failure Asynchronous error: Module failure
OB100 OB100 Startup Restart
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Table A-3 Migratable functions (FC) and function blocks (FB)
Address Symbol in basic PLC program version Functionality Availability in V6.15

Up to V4.9x As of V6.x (SINUMERIK 
ONE)

FB29 Diagnostics -- Diagnostic routines for the 
PLC user program with log‐
ging of signal states and sig‐
nal changes.

In the TIA Portal, the system diagnos‐
tics provide this functionality. Conse‐
quently, as of V6.x, FB29 is no longer a 
direct part of the basic PLC program, 
but rather is now are available as sam‐
ple application.
An existing FB29 from the basic pro‐
gram ≤ V4.9x can be migrated to a 
SINUMERIK ONE and reused, provided 
the block is not know-how protected. 
See: Revoking know-how protection 
of type "KNOW_HOW_PROTECT" 
(Page 60)

FC12 FC12 LBP_CallBackAuxFunc Call interface for users for 
auxiliary functions, the block 
is called on an event-driven 
basis in the basic program 
when new auxiliary func‐
tions are available.

Is migrated. Requires the internal 
LBP_InternalProc4[FC25003] block 
provided write-protected in the library.
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A.1.2 Blocks of the PLC basic program that cannot be migrated (automatically)
All blocks of the SINUMERIK basic PLC program that are not migrated automatically to a 
SINUMERIK ONE are listed below. The blocks are available as new version for SINUMERIK ONE, 
except for PI_SERV [FB4], SI_Relay [FB10], SI_BrakeTest [FB11], Diagnostics [FB29], GP_DIAG 
[FC5], TM_DIR [FC22], FC1005 [FC1005] and FC1006 [FC1006], which are no longer supported.

Table A-4 Non-migratable function blocks (FBs)
Address Symbol Functionality Availability in 

V6.15
Blocks/
functions
 usedUp to V4.9x As of V6.15

(SINUMERIK ONE)
FB1 RUN_UP -- The block configures and ini‐

tializes the basic program, 
starts synchronization be‐
tween PLC and NCK, is called 
in the OB Startup [OB100] 
with instance DB LBP_In‐
stConfig [DB7].
Note:
The version identification 
can be found for FC1 at User‐
VersionString.

FB1 has been replaced 
with FC1, and is no lon‐
ger part of the basic 
PLC program as of V6.x.
See also FB1 and FC1 
comparison (Page 139)

 

FB2 GET LBP_ReadVar The block reads NC variables. Available FC25000
FC25001
FC25004
FB1020
DB1020
DB2
DB3
DB5
DB8

FB3 PUT LBP_WriteVar The block writes NC varia‐
bles.

Available FC25000
FC25001
FC25004
FB1020
DB1020
DB2
DB3
DB5
DB8

FB4 PI_SERV  -- The block starts PI services No longer supported as 
of V6.x. Use LBP_ReqPI‐
Service [FB7] instead.

 

FB5 GETGUD LBP_ReadGUD The block reads global user 
data (GUD) from the NC and 
determines the GUD variable 
address.

Available FC25000
FC25001
FC25004
FB1020
DB1020
DB2
DB3
DB5
DB8

Appendix A
A.1 PLC basic program blocks

Migration to a SINUMERIK ONE
134 System Manual, 07/2021, A5E47495977B AD



Address Symbol Functionality Availability in 
V6.15

Blocks/
functions
 usedUp to V4.9x As of V6.15

(SINUMERIK ONE)
FB7 PI_SERV2 LBP_ReqPIService The block starts PI services 

defined in the LBP_PIServices 
[DB16].

Available FC25000
FC25001
FC25004
FB1020
DB1020
DB2
DB3
DB5
DB8
DB16

FB9 M2N LBP_M2NSwitchOver The block switches over con‐
trol components (MCP/OP) 
connected with one or sever‐
al control modules NCU; it 
uses the signals from 
LBP_HMI [DB19].

No longer supported as 
of V6.x.
The MCP must be 
switched over in the 
user program. (See FB9 
MCP switchover 
(Page 112))

 

FB10 SI_Relais -- Safety relay Safety Integrated (SPL) 
is no longer supported. 
Block removed.
See: Converting the 
safety functionality 
(Page 123)

 

FB11 SI_BrakeTest -- Brake test Safety Integrated (SPL) 
is no longer supported. 
Block removed.
See: Converting the 
safety functionality 
(Page 123)

 

FB21 Powerride LBP_Powerride Block is used to control a 
Powerride rotary/push 
switch.

Available  (no depend‐
encies)
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Table A-5 Non-migratable functions (FC)
Address Symbol Functionality Availability in 

V6.15
Blocks/
functions 
usedUp to V4.9x As of V6.15

(SINUMERIK ONE)
FC1 -- LBP_ConfigBP The block configures and ini‐

tializes the basic program, 
starts synchronization be‐
tween PLC and NCK, is called 
in the OB Startup [OB100].

Available
As of V6.x, FC1 replaces 
FB1 (≤ 4.9x).
See also: Replacing the 
call of LBP_ConfigBP 
[FB1] in OB Startup 
[OB100] with LBP_Con‐
figBP [FC1] (Page 109)

FC25001
FC25004
FB1020
DB1020
DB7
DB8

FC2 GP_HP LBP_MainBP The block processes the cy‐
clic part of the basic pro‐
gram, must be called at the 
start of Main [OB1]

Available FC25001
FC25003
FC25004
FB1020
DB1020
DB2
DB3
DB5
DB8

FC3 GP_PRAL LBP_NCKProcessIRT The block processes the 
block-synchronous part of 
the basic program, must be 
called at the start of Hard‐
ware interrupt [OB40].

As of V6.x, FC3 is sup‐
ported in hardware in‐
terrupt OBs. For this 
purpose, FC3, for exam‐
ple, must be called in 
OB40 at the beginning. 
Output parameters 
(formerly GP_* local da‐
ta in OB40) are not yet 
supported in V6.x, this 
is possible as of V6.13. 
To obtain these output 
parameters, a variable 
of type "LBP_type‐
NCKProcessIRTFlags" 
must be created and 
transferred to the 
"Flags" parameter.
See also: Supplementa‐
ry conditions for calling 
LBP_NCKProcessIRT 
[FC3] in OB hardware 
interrupt [OB40] 
(Page 111)

FC25001
FC25003
FB1020
DB1020
DB2
DB3
DB5
DB8
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Address Symbol Functionality Availability in 
V6.15

Blocks/
functions 
usedUp to V4.9x As of V6.15

(SINUMERIK ONE)
FC5 GP_DIAG -- The block records module 

disruptions and failures; it 
must be called at the begin‐
ning of the following OB: Di‐
agnostic error interrupt 
[OB82], pull or plug of mod‐
ules [OB 83], rack or station 
fault [OB86].

In the TIA Portal, the 
system diagnostics pro‐
vide this functionality. 
FC5 is therefore no lon‐
ger part of the basic 
PLC program as of V6.x.

 

FC6 TM_TRANS2 LBP_TMTransferMT The block transfers position 
and status information of 
the tools to the tool manage‐
ment interface in connec‐
tion with Multitool.

Available FC25001
FC25004
FB1020
DB1020
DB2
DB3
DB5
DB8

FC7 TM_REV LBP_TMTransferTurret The block acknowledges an 
implemented tool change of 
a turret to the tool manage‐
ment interface.

Available FC25001
FC25004
FB1020
DB1020
DB2
DB3
DB5
DB8

FC8 TM_TRANS LBP_TMTransfer The block transfers position 
and status information of 
the tools to the tool manage‐
ment interface.

Available FC25001
FC25004
FB1020
DB1020
DB2
DB3
DB5
DB8

FC9 ASUB LBP_ReqASUP The block starts asynchro‐
nous subprograms, the pre‐
requisite is that it must be se‐
lected and parameterized by 
an NC program or by the 
LBP_ReqPIService [FB7] (PI 
service ASUP).

Available FC25001
FC25004

FC10 AL_MSG LBP_GenerateAlarmMsgs The block evaluates the sig‐
nals entered in 
LBP_AlarmMsgs [DB2], gen‐
erates incoming and outgo‐
ing error and operating mes‐
sages of the operating soft‐
ware and acknowledges er‐
ror messages. Optionally, in‐
fluencing of the block and 
stop signals can be per‐
formed.

Available FB1020
DB1020
DB2
DB3
DB5
DB7
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Address Symbol Functionality Availability in 
V6.15

Blocks/
functions 
usedUp to V4.9x As of V6.15

(SINUMERIK ONE)
FC13 BHGDisp LBP_HTCtrlHT2 Block carries out the display 

control of the handheld unit 
(HT 2).

Available  

FC17 YDelta LBP_CtrlStarDelta The block is used for star-del‐
ta changeover for digital 
main spindle drives.

Available FC25004

FC18 SpinCtrl LBP_CtrlAxisSpindle The block controls axes and 
spindles from the user pro‐
gram.

Available FC25001
FC25004

FC19 MCP_IFM LBP_MCPCtrlMilling The block transfers data 
from the machine control 
panel (MCP milling version) 
to the NC/PLC interface.

Available FC25004
FB1020
DB1020
DB2
DB3
DB5
DB7
DB8
DB10
DB11

FC21 Transfer LBP_TransferSelData The block is used for high-
speed data exchange be‐
tween PLC and NCK.

Available FC25001
FC25004
FB1020
DB1020
DB2
DB3
DB5
DB8

FC22 TM_DIR -- The block provides the short‐
est path and direction of mo‐
tion for positioning a tool 
magazine or turret (indexing 
axis).

As of V6.x, FC22 is no 
longer part of the basic 
PLC program and must 
be emulated in the user 
program.

 

FC24 MCP_IFM2 LBP_MCPCtrlMillingSmall The block transfers data 
from the machine control 
panel (MCP milling version 
compact) to the NC/PLC in‐
terface.

Available FC25004

FC25 MCP_IFT LBP_MCPCtrlTurning The block transfers data 
from the machine control 
panel (MCP turning version) 
to the NC/PLC interface.

Available FC25004

FC26 HPU_MCP LBP_HTCtrlHT8 The block is used to transfer 
HT 8 data and HT 10 data to 
the NC/PLC interface.

Available  

FC27 OpUnitWriteR‐
ecord

LBP_OpUnitWriteRecord The block writes a data re‐
cord to a SINUMERIK ONE 
MCP.

Available  
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Address Symbol Functionality Availability in 
V6.15

Blocks/
functions 
usedUp to V4.9x As of V6.15

(SINUMERIK ONE)
FC1005 FC1005 -- Transfers data to the Ether‐

net CP.
FC1005 is no longer 
part of the basic PLC 
program as of V6.x.
Instead, use the appro‐
priate operations for 
"S7 communication" 
and "Open user com‐
munication" (task card 
"operations").
See also: Create MyVir‐
tual Machine System 
Manual, Chapter "Re‐
strictions for compo‐
nents, communication 
interfaces".

 

FC1006 FC1006 -- Receives data from the Ether‐
net CP.

FC1006 is no longer 
part of the basic PLC 
program as of V6.x.
Instead, use the appro‐
priate operations for 
"S7 communication" 
and "Open user com‐
munication" (task card 
"operations").
See also: Create MyVir‐
tual Machine System 
Manual, Chapter "Re‐
strictions for compo‐
nents, communication 
interfaces".

 

A.1.3 FB1 and FC1 comparison
FB1 has been replaced with FC1, and is no longer part of the basic PLC program as of V6.x.
Compared with FB1, FC1 has different input/output parameters, also with different names and 
types. The following figures provide an overview of the differences:
• Red: signal from FB1 absent for FC1
• Green: signal from FB1 renamed for FC1
• Blue: changed default
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Figure A-1 Comparison of FB1 SINUMERIK 840D sl (left) and FC1 SINUMERIK ONE (right) 
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Figure A-2 Comparison of FB1 SINUMERIK 840D sl (left) and FC1 SINUMERIK ONE (right) 

See also
Replacing the call of LBP_ConfigBP [FB1] in OB Startup [OB100] with LBP_ConfigBP [FC1] 
(Page 109)
Blocks of the PLC basic program that cannot be migrated (automatically) (Page 134)
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A.1.4 Interface DB of the PLC basic program
The symbolic addressing requires that all project blocks used in the TIA Portal, including PLC 
interface data blocks of the basic program, must be defined in the project. The associated PLC 
data types (UDT) are available as copy templates. 

Block Symbolic block name PLC data type
up to V4.90 as of V6.x 

(SINUMERIK ONE)
SINUMERIK 840D sl SINUMERIK ONE

DB2 ALMSG_DB LBP_AlarmMsgs UDT1002
See also: User alarm con‐
cept (DB2) (Page 35)

LBP_type_AlarmMsgs

DB10 NC LBP_NC UDT10 LBP_typeNC
DB11 Mode group LBP_ModeGroup UDT11 LBP_typeModeGroup
DB19 MMC LBP_HMI UDT19 LBP_typeHMI
DB21…DB30 Chan1…Chan10 LBP_Chan1…LBP_Chan10 UDT21 LBP_typeChanX
DB31…DB61 Axis1…Axis31 LBP_Axis1…LBP_Axis31 UDT31 LBP_typeAxisX
DB71 TMLoadIF LBP_TMLoad UDT71 LBP_typeTMLoad
DB72 TMSpindleIF LBP_TMSpindle UDT72 LBP_typeTMSpindle
DB73 TMRevIF LBP_TMTurret UDT73 LBP_typeTMTurret
DB1071 TMLoadIF_MT LBP_TMLoadMT UDT1071 LBP_typeTMLoadMT
DB1072 TMSpindleIF_MT LBP_TMSpindleMT UDT1072 LBP_typeTMSpindleMT
DB1073 TMRevIF_MT LBP_TMTurretMT UDT1073 LBP_typeTMTurretMT

A.1.5 Comparison of the old and the new symbolics of the basic program blocks
To migrate a SINUMERIK 840D sl from a TIA Portal project to a SINUMERIK ONE, you must 
manually change the symbolic names of the basic PLC program blocks. The following table 
illustrates this.

Absolute address Symbolic block name
SINUMERIK 840D sl SINUMERIK ONE

FC2 GP_HP LBP_MainBP
FC3 GP_PRAL LBP_NCKProcessIRT
FC5 GP_DIAG --
FC6 TM_TRANS2 LBP_TMTransferMT
FC7 TM_REV LBP_TMTransferTurret
FC8 TM_TRANS LBP_TMTransfer
FC9 ASUB LBP_ReqASUP
FC10 AL_MSG LBP_GenerateAlarmMsgs
FC12 FC12 LBP_CallBackAuxFunc
FC13 BHGDisp LBP_HTCtrlHT2
FC17 YDelta LBP_CtrlStarDelta
FC18 SpinCtrl LBP_CtrlAxisSpindle
FC19 MCP_IFM LBP_MCPCtrlMilling
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Absolute address Symbolic block name
SINUMERIK 840D sl SINUMERIK ONE

FC21 Transfer LBP_TransferSelData
FC22 TM_DIR --
FC24 MCP_IFM2 LBP_MCPCtrlMillingSmall
FC25 MCP_IFT LBP_MCPCtrlTurning
FC26 HPU_MCP LBP_HTCtrlHT8
FB1 → FC1 RUN_UP LBP_ConfigBP
FB2 GET LBP_ReadVar
FB3 PUT LBP_WriteVar
FB4 PI_SERV --
FB5 GETGUD LBP_ReadGUD
FB7 PI_SERV2 LBP_ReqPIService
FB9 M2N LBP_M2NSwitchOver
FB21 Powerride LBP_Powerride
FB29 Diagnostics --
DB2 ALMSG_DB LBP_AlarmMsgs
DB4 DB4 --
DB5 DB5 LBP_ParamAlarmMsgs
DB7 gp_par LBP_ConfigData
DB8 DB8 LBP_InternalDB8
DB10 NC LBP_NC
DB11 Mode group LBP_ModeGroup
DB15 DB15 --
DB16 PI LBP_PIServices
DB17 DB17 --
DB18 SPL --
DB19 MMC LBP_HMI
DB21 Chan1 LBP_Chan1
DB31 Axis1 LBP_Axis1
DB71 TMLoadIF LBP_TMLoad
DB72 TMSpindleIF LBP_TMSpindle
DB73 TMRevIF LBP_TMTurret
DB75 DB_MDec_List LBP_MFuncDecListConfig
DB76 DB_M_Funktionen LBP_MFuncDecListSignals
DB77 DB77 --
DB78 PowerrideConfig LBP_PowerrideConfig
DB1000 CtrlE LBP_CtrlEnergy
DB1001 SentronPac LBP_SentronPac
DB1002 ISM_TS LBP_SpindleTempSensor
DB1071 TMLoadIF_MT LBP_TMLoadMT
DB1072 TMSpindleIF_MT LBP_TMSpindleMT
DB1073 TMRevIF_MT LBP_TMTurretMT
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A.2 Comparison of the addresses in DB2
The addresses of the two DB2 variants are compared below:
• DB2 without alarm extension (≤ V4.9x or 840D sl)
• DB2 with alarm extension (≤ V4.9x or 840D sl and V6.x or ONE)

Note: DB2 with alarm extension (840D sl) differs from DB2 of the ONE by having a changed 
identifier. As of ONE, "ZInfo0" is called "AddValUserA0".

Table A-6 Comparison of the addresses in the DB2 variants
Alarm num‐
ber

DB2 without alarm extension Offset DB2 with alarm extension
Area Offset Offset Area

-    0
 

Chan
(Channel 1 ... 10)

-    120
 

Axis
(Axis/spindle 1 ... 31)

Additional 
value

   182
 

as of V6.x: AddValUserA0 
(AddValUserA0 0 ... 63)
(Up to V4.8: ZInfo0 
0 ... 63)

5C0000 ... 
5C1315

(C1 ... C8)
Channel 1 ... 8

Byte 0 ... <last byte for 
channel area>
 
 

310 Byte 310 ... <last byte for 
channel area>
 

ChanA
Channel 1 ... 10

60AA00 ... 
60AA15

(Axis areas)
Axis/spindle
1 ... 18

Byte 144 ... <last byte for 
axis area>
 

346 Byte 490 ... <last byte for 
axis area>
 

AxisA
Axis/spindle 1 ... 31

70UU00 ... 
70UU63

(User area)
User area
0 ... 31

Byte 180 ... <last byte for 
user area>

374 Byte 554 ... <last byte for 
user area>

UserA
User area 0 ... 63
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A.3 Comparison of symbolic identifiers for DB2 signals
In the user program, address a DB signal symbolically as follows:
"<symbolic name of the block>".<symbolic identifier of the signal>
This means a signal for DB2 is addressed differently depending on whether or not the symbolic 
name of the block has already been adapted:
• "ALMSG_DB".<symbolic identifier of the signal> 
• "LBP_AlarmMsgs".<symbolic identifier of the signal>

Overview
The symbolic identifiers of the signal addresses for the two DB2 variants are compared below:
• DB2 without alarm extension (≤ V4.9x or 840D sl)
• DB2 with alarm extension (≤ V4.9x or 840D sl and V6.x or ONE)
For this purpose, the signals of the 3 signal areas (channel signals (Page 145), axis/spindle 
signals (Page 145), user area signals (Page 145)) are compared separately.

Note
DB2 with alarm extension for 840D sl and ONE: Changed ZInfo0 identifier
Note: DB2 with alarm extension (840D sl) differs from DB2 of the ONE by having a changed 
identifier. As of ONE, "ZInfo0" is called "AddValUserA0":
• If you convert from DB2 without alarm extension to DB2 with alarm extension, you do not 

need to make any additional adaptation, because AddValUserA0 or ZInfo0 is available only 
with the alarm extension.

• It you have already deployed DB2 with alarm extension on the 840D sl, you may need to 
convert the calls in your user program.

Comparison of the symbolic signal identifiers from the channel area (1 … 8)
The symbolic identifiers of the signals in the channel area differ as follows:

DB2 without alarm extension DB2 with alarm extension
Cj.FDD_5j00xx[i] ChanA[j].FDD_5C00xx[i]
Cj.FDD_RID_5j01xx[i] ChanA[j].FDD_RID_5C01xx[i]
Cj.RID_5j02xx[i] ChanA[j].RID_5C02xx[i]
Cj.NCSD_5j03xx[i] ChanA[j].NCSD_5C03xx[i]
Cj.FdStop_1_5j11xx[i] ChanA[j].FdStop_1_5C11xx[i]
Cj.FdStop_2_5j12xx[i] ChanA[j].FdStop_2_5C12xx[i]
Cj.FdStop_3_5j13xx[i] ChanA[j].FdStop_3_5C13xx[i]

j (shown bold): Insert the associated addressed channel number (1 … 8)
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Example for channel 1 (j = 1):

C1.FDD_5100xx[i] ChanA[1].FDD_5C00xx[i]

Comparison of the symbolic signal identifiers from the axis/spindle area (1 … 18)
The symbolic identifiers of the signals in the axis/spindle area differ as follows:

DB2 without alarm extension DB2 with alarm extension
_jFdStop600jxx[i] AxisA[j].AAFdStop60AAxx[i]
_jjFdStop60jjxx[i] AxisA[jj].AAFdStop60AAxx[i]

j or jj (shown bold): Insert the associated axis/spindle number (1 ... 9 or 10 … 18)

Comparison of the symbolic signal identifiers from the user area (00 … 31)
The symbolic identifiers of the signals in the user area differ as follows:

DB2 without alarm extension DB2 with alarm extension
A70jjxx[i] UserA[jj].A70UUxx[i]

jj (shown bold): Insert the associated address user area (00 … 31)
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A.4 Comparison of symbolic identifiers for DB7 
The following table shows the symbolic differences between the old instance DB7 and the new 
global DB7. Symbols not listed here have not been changed. In general, the meaning of the 
values has not changed and the offsets within DB7 are also unchanged. 

 
DB7 symbol 840D sl

 
DB7 symbol ONE

 
Offset

 
MCP1StatSend

 
reservedByte14_25

 
14.0

 
MCP1StatRec

 
20.0

 
MCP1Cycl

 
reservedByte30_31

 
30.0

 
MCP2StatSend

 
reservedByte44_55

 
44.0

 
MCP2StatRec

 
50.0

 
MCP2Cycl

 
reservedByte60_61

 
60.0

 
MCPMPI

 
reservedBool62_0

 
62.0

 
MCPSDB210

 
reservedBool62_5

 
62.5

 
MCPCopyDB77

 
reservedBool62_6

 
62.6

 
BHG

 
HTIf

 
64.0

 
BHGIn

 
HTIn

 
66.0

 
BHGOut

 
HTOut

 
72.0

 
BHGStatSend

 
reservedByte78_95

 
78.0

 
BHGStatRec

 
84.0

 
BHGInLen

 
90.0

 
BHGOutLen

 
91.0

 
BHGTimeout

 
92.0

 
BHGCycl

 
94.0
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BHGRecGDNo

 
HTAdr

 
96.0

 
BHGRecGBZNo

 
reservedByte98_107

 
98.0

 
BHGRecObjNo

 
100.0

 
BHGSendGDNo

 
102.0

 
BHGSendGBZNo

 
104.0

 
BHGSendObjNo

 
106.0

 
BHGMPI

 
reservedBool108_0

 
108.0

 
BHGStop

 
HTStop

 
108.1

 
BHGNotSend

 
HTNotSend

 
108.2

 
NCKomm

 
reservedBool116_0

 
116.0

 
ExtendAlMsg

 
reservedBool116_3

 
116.3

 
UserIR

 
reservedBool120_0

 
120.0

 
OpKeyBusType

 
reservedByte159

 
159.0

 
MaxBAG

 
MaxModeGroup

 
166.0

 
ActivChan

 
ActiveChan

 
172.0

 
ActivAxis

 
ActiveAxis

 
174.0

 
UDInt

 
MaxNumUserDataInt

 
178.0

 
UDHex

 
MaxNumUserDataHex

 
180.0

 
UDReal

 
MaxNumUserDataReal

 
182.0

 
MCP1_Poi

 
reservedByte188_199

 
188.0

 
MCP2_Poi

  
192.0

 
BHG_Poi

  
196.0
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GPVersion

 
BPVersion

 
200.0

 
-

 
UserVersionString

 
246.0

See also
Replacing the call of LBP_ConfigBP [FB1] in OB Startup [OB100] with LBP_ConfigBP [FC1] 
(Page 109)

Appendix A
A.4 Comparison of symbolic identifiers for DB7 

Migration to a SINUMERIK ONE
System Manual, 07/2021, A5E47495977B AD 149



A.5 Migration log and compilation messages
The migration log, the messages from the compilation and the tables in this chapter help you 
with assessing the migration result.
These messages are separated into errors and warnings. Errors must always be rectified so that 
the program can be compiled and can run. Warnings must be checked individually to determine 
whether they lead to problems.
Check in which step of the migration process an error can be rectified easiest:
• In STEP 7 V5.5 SP4:

Many problems can be rectified easier in STEP 7 V5.5 SP4 before you migrate the project to 
the TIA Portal, e.g. because of the changed operand priority (absolute/symbolic).

• In the TIA Portal on the SINUMERIK 840D sl project
• After PLC migration to the SINUMERIK ONE

A.5.1 Frequent errors/warnings during migration

Table A-7 Migration log: Frequent errors and warnings
Error/warning Remark Removal
The following blocks could not 
be migrated (error)

If this error lists only blocks of the PLC program that 
cannot be migrated (automatically) (Page 134), you 
should check whether they have been converted cor‐
rectly to dummy blocks.

After migration

If blocks of your PLC user program could not be migra‐
ted, remove the know-how protection and repeat the 
migration.

On the starting project

If blocks from other manufacturers or option packages 
are listed, check whether they are available for the 
TIA Portal.

Refer to the documentation of 
the associated manufacturer or 
option package

The block contains operations 
that address hardware modules. 
Specify the hardware ID of the 
new modules. (Error)

The SINUMERIK ONE uses symbolic hardware identifica‐
tions (HWID) rather than the previous diagnostic ad‐
dresses. 
The hardware identifications of a module can be found 
in its properties at "System constants".
Replace the hardware identifications in the associated 
parameters and operations (e.g. LADDR, ID, D_ACT_DP, 
DPRD_DAT, DPWR_DAT, GADR_LGC).
See also: TIA Portal online help, search term "Help for the 
PLC migration:22"

After PLC migration and the in‐
terconnection of the hardware 
(Page 83)

The partially qualified address 
cannot be converted to a fully 
qualified address. (Error)

When addressing a DB variable in the user program, no 
symbolic name could be augmented. Absolute (partially 
qualified) access to the variable is still made in the mi‐
grated user program.
Even when no error is displayed in the block editor, this 
must be checked and rectified appropriately.
See also: TIA Portal online help, search term "Help for the 
PLC migration:5"

On the starting project or after 
migration
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Error/warning Remark Removal
The "EN" and "ENO" parameters 
may not be interconnected when 
calling the TON/TOF function. 
(Warning)

S7-1500 and SINUMERIK ONE no longer support this 
procedure. Adapt the operation.
See: TIA Portal online help, search term "Help for the PLC 
migration:6"

After PLC migration

The following operations called 
in the program are no longer sup‐
ported by the S7-1500:
'WR_USMSG'
(Error)

The S7-1500 does not have any generally-valid replace‐
ment for the WR_USMSG.
See also: TIA Portal online help, search term "SINUMERIK 
user alarm"
Note:
You can make diagnostic buffer entries with the 
"Gen_UsrMsg" command.

After PLC migration

A.5.2 Frequent compilation messages

Table A-8 Compiling the software after migration: Frequent errors/warnings
Error/warning Remark Removal
The called block DBxy in network x does 
not exist. (Warning)

To access signals of a data block, it must exist in the TIA 
Portal project.
See: Addressing a DB that does not exist in the project 
(Page 39)

On the starting project

• 'LBP_DB2AlarmTypeErrMsg' contains 
invalid text"

• The 'LBP_DB2AlarmTypeOpMsg' 
message contains invalid text"

• The 'LBP_DB2AlarmTypeInfoMsg' 
message contains invalid text"

• The 'LBP_UserAlarmTypeErrMsg' 
message contains invalid text"

• 'LBP_UserAlarmTypeOpMsg' con‐
tains invalid text"

• 'LBP_UserAlarmTypeInfoMsg' con‐
tains invalid text"

• 'LBP_UserAlarmTypeAckMsg' con‐
tains invalid text"

(Warnings)

These warnings are displayed when you use DB2 alarms 
in the user program without importing the DB2 alarm 
texts from SINUMERIK Operate into the TIA Portal.
Importing DB2 alarm texts is optional. If DB2 alarm texts 
are not imported, you can display them only in SINU‐
MERIK Operate, but not in the TIA Portal, via the Web 
server of the PLC or via Get_Alarm [FB702].
See: TIA Portal online help, search term "Importing DB2 
alarms"

After PLC migration

The variable 'abc' is declared as Output, 
and cannot be read. (Warning)

Writing input parameters or reading output parameters 
is no longer possible.
• If the modification of the input parameter or the 

read-back of the output parameter should be re‐
tained, you can use InOut parameters.

• Otherwise use temporary variables that are initial‐
ized explicitly.

See: TIA Portal online help, search term "Pass parameter 
as copy or pointer"

On the starting project

The variable 'xyz' is declared as Input, 
and cannot be written. (Warning)
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Error/warning Remark Removal
The address is not occupied by a variable. 
(Warning)

The reason for this warning is often an access of the 
following type to an address of a DB:
For example, absolute access to an address area of 2 
bytes where the individual bytes have symbolic names, 
but not the 2-byte Word.
When you rectify such problems before the migration, 
automatic addressing can be converted to symbolic ad‐
dressing.

On the starting project

The element is not supported in this lan‐
guage version. (Error)

Relates to programming procedures that are no longer 
supported with S7-1500 and SINUMERIK ONE.
Check the associated error for the network and the block 
in the migration log.

After PLC migration

The referenced "xyz" block no longer ex‐
ists. (Error)

See Frequent errors/warnings during migration 
(Page 150), error "The following blocks could not be 
migrated"

See there

The "<block name>" data type no longer 
exists. (Error)
The called "abc" block in network "xyz" 
does not exist. (Error)
The data type x of the actual parameter 
does not match the data type y of the 
formal parameter. (Error)

Data type conflict that can result for the automatic con‐
version of the user program to symbolic addressing.
Ideally, adapt the user program before the migration. 
Alternatively, you can correct the data type of the 
named parameter in the block editor after the migration.
See: Checking the user program for required adapta‐
tions (Page 63)

On the starting project
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A.6 Standard telegram configuration of a SINUMERIK ONE

A.6.1 SINUMERIK-conformal telegram configuring

Rules for SINUMERIK-conformal telegram configuring of SINAMICS drives
To configure the data exchange between a SINUMERIK 828D, SINUMERIK 840D sl, SINUMERIK 
ONE or SINUMERIK MC and SINAMICS S120 drives, the following rules must be observed for the 
PROFIBUS/PROFINET configuration of the drives: 
• For the SINAMICS drives (CU3xx) on PROFIBUS/PROFINET, the PROFIBUS/PROFINET 

configuration must be identical to the standard configuration of the telegrams of the drives 
on the integrated PROFIBUS (SINAMICS Integrated or NX) of a SINUMERIK 828D, SINUMERIK 
840D sl or SINUMERIK ONE with regard to the structure of the telegrams.

• The identical structure of the telegrams refers specifically to the sequence of telegrams for a 
drive (CU3xx). The telegrams must be configured in the following order: 
– Telegrams for SERVO or HLA drive objects
– Telegram for the control unit drive object 
– Telegram for the infeed drive object 

• The following rules must be observed for the telegrams of the individual drive objects:
– The input and output address of a telegram must have the same value.

Exception: User-specific telegrams that only have input or output values.
– The input and output data of a telegram are generally transferred via the same slot. If two 

different slots are used for data exchange (for PROFIBUS or PROFIBUS Integrated), make 
sure that the input slot is defined first. The output slot must have the following slot 
number.

A.6.2 PROFIdrive telegrams for standard data
The I/O addresses of standard telegrams are compared to the following telegram configurations 
in the following:
• SINUMERIK ONE, from V6.14
• SINUMERIK 840D sl, from V4.94

Table A-9 SINAMICS Integrated: I/O addresses of PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis01 SIEMENS telegram 136 4100 4100 13050[0]
DriveAxis02 SIEMENS telegram 136 4140 4140 13050[1]
DriveAxis03 SIEMENS telegram 136 4180 4180 13050[2]
DriveAxis04 SIEMENS telegram 136 4220 4220 13050[3]
DriveAxis05 SIEMENS telegram 136 4260 4260 13050[4]
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Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis06 SIEMENS telegram 136 4300 4300 13050[5]
DriveCU01 SIEMENS telegram 391 6500 6500 13120[0]
Infeed01 SIEMENS telegram 370 6514 6514  

Table A-10 NX on DRIVE-CLiQ socket X105; DP address 15: I/O addresses of PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis07 SIEMENS telegram 136 4340 4340 13050[6]
DriveAxis08 SIEMENS telegram 136 4380 4380 13050[7]
DriveAxis09 SIEMENS telegram 136 4420 4420 13050[8]
DriveAxis10 SIEMENS telegram 136 4460 4460 13050[9]
DriveAxis11 SIEMENS telegram 136 4500 4500 13050[10]
DriveAxis12 SIEMENS telegram 136 4540 4540 13050[11]
DriveCU02 SIEMENS telegram 390 6530 6530  
Infeed02 SIEMENS telegram 370 6534 6534  

Table A-11 NX on DRIVE-CLiQ socket X104; DP address 14: I/O addresses of PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis13 SIEMENS telegram 136 4580 4580 13050[12]
DriveAxis14 SIEMENS telegram 136 4620 4620 13050[13]
DriveAxis15 SIEMENS telegram 136 4660 4660 13050[14]
DriveAxis16 SIEMENS telegram 136 4700 4700 13050[15]
DriveAxis17 SIEMENS telegram 136 4740 4740 13050[16]
DriveAxis18 SIEMENS telegram 136 4780 4780 13050[17]
DriveCU03 SIEMENS telegram 390 6540 6560  
Infeed03 SIEMENS telegram 370 6544 6554  

Table A-12 NX on DRIVE-CLiQ socket X103; DP address 13: I/O addresses of PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis19 SIEMENS telegram 136 4820 4820 13050[18]
DriveAxis20 SIEMENS telegram 136 4860 4860 13050[19]
DriveAxis21 SIEMENS telegram 136 4900 4900 13050[20]
DriveAxis22 SIEMENS telegram 136 4940 4940 13050[21]
DriveAxis23 SIEMENS telegram 136 4980 4980 13050[22]
DriveAxis24 SIEMENS telegram 136 5020 5020 13050[23]
DriveCU04 SIEMENS telegram 390 6550 6590  
Infeed04 SIEMENS telegram 370 6554 6574  
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Table A-13 NX on DRIVE-CLiQ socket X102; DP address 12: I/O addresses of PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis25 SIEMENS telegram 136 5060 5060 13050[24]
DriveAxis26 SIEMENS telegram 136 5100 5100 13050[25]
DriveAxis27 SIEMENS telegram 136 5140 5140 13050[26]
DriveAxis28 SIEMENS telegram 136 5180 5180 13050[27]
DriveAxis29 SIEMENS telegram 136 5220 5220 13050[28]
DriveAxis30 SIEMENS telegram 136 5260 5260 13050[29]
DriveCU05 SIEMENS telegram 390 6560 6620  
Infeed05 SIEMENS telegram 370 6564 6594  

Table A-14 NX on DRIVE-CLiQ socket X101; DP address 11: I/O addresses of PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis31 SIEMENS telegram 136 5300 5300 13050[30]
DriveAxis32 SIEMENS telegram 136 5340 5340  
DriveAxis33 SIEMENS telegram 136 5380 5380  
DriveAxis34 SIEMENS telegram 136 5420 5420  
DriveAxis35 SIEMENS telegram 136 5460 5460  
DriveAxis36 SIEMENS telegram 136 5500 5500  
DriveCU06 SIEMENS telegram 390 6570 6650  
Infeed06 SIEMENS telegram 370 6574 6614  

Table A-15 NX on DRIVE-CLiQ socket X100; DP address 10: I/O addresses of PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis37 SIEMENS telegram 136 5540 5540  
DriveAxis38 SIEMENS telegram 136 5580 5580  
DriveAxis39 SIEMENS telegram 136 5620 5620  
DriveAxis40 SIEMENS telegram 136 5660 5660  
DriveAxis41 SIEMENS telegram 136 5700 5700  
DriveAxis42 SIEMENS telegram 136 5740 5740  
DriveCU07 SIEMENS telegram 390 6580 6680  
Infeed07 SIEMENS telegram 370 6584 6634  

A.6.3 PROFIsafe/PROFIdrive telegrams for Safety Integrated (F-PLC)
The I/O addresses of safety-relevant telegrams are compared to the following telegram 
configurations in the following:
• SINUMERIK ONE, from V6.14
• SINUMERIK 840D sl, from V4.94
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From the firmware versions of SINUMERIK ONE, the I/O addresses of SIEMENS telegram 903 no 
longer have to be entered in the machine data. The corresponding item in the 840D sl machine 
data is therefore not imported to the SINUMERIK ONE during the SINUMERIK archive migration.

Table A-16 SINAMICS Integrated: I/O addresses of PROFIsafe/PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis01 SIEMENS telegram 903 6700 1008 -
DriveAxis01 SIEMENS telegram 701 5800 5800 13374[0]
DriveAxis02 SIEMENS telegram 903 6716 992 -
DriveAxis02 SIEMENS telegram 701 5816 5816 13374[1]
DriveAxis03 SIEMENS telegram 903 6732 976 -
DriveAxis03 SIEMENS telegram 701 5832 5832 13374[2]
DriveAxis04 SIEMENS telegram 903 6748 960 -
DriveAxis04 SIEMENS telegram 701 5848 5848 13374[3]
DriveAxis05 SIEMENS telegram 903 6764 944 -
DriveAxis05 SIEMENS telegram 701 5864 5864 13374[4]
DriveAxis06 SIEMENS telegram 903 6780 928 -
DriveAxis06 SIEMENS telegram 701 5880 5880 13374[5]

Table A-17 NX on DRIVE-CLiQ socket X105; DP address 15: I/O addresses of PROFIsafe/PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis07 SIEMENS telegram 903 6796 912 -
DriveAxis07 SIEMENS telegram 701 5896 5896 13374[6]
DriveAxis08 SIEMENS telegram 903 6812 896 -
DriveAxis08 SIEMENS telegram 701 5912 5912 13374[7]
DriveAxis09 SIEMENS telegram 903 6828 880 -
DriveAxis09 SIEMENS telegram 701 5928 5928 13374[8]
DriveAxis10 SIEMENS telegram 903 6844 864 -
DriveAxis10 SIEMENS telegram 701 5944 5944 13374[9]
DriveAxis11 SIEMENS telegram 903 6860 848 -
DriveAxis11 SIEMENS telegram 701 5960 5960 13374[10]
DriveAxis12 SIEMENS telegram 903 6876 832 -
DriveAxis12 SIEMENS telegram 701 5976 5976 13374[11]

Table A-18 NX on DRIVE-CLiQ socket X104; DP address 14: I/O addresses of PROFIsafe/PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis13 SIEMENS telegram 903 6892 816 -
DriveAxis13 SIEMENS telegram 701 5992 5992 13374[12]
DriveAxis14 SIEMENS telegram 903 6908 800 -
DriveAxis14 SIEMENS telegram 701 6008 6008 13374[13]
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Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis15 SIEMENS telegram 903 6924 784 -
DriveAxis15 SIEMENS telegram 701 6024 6024 13374[14]
DriveAxis16 SIEMENS telegram 903 6940 768 -
DriveAxis16 SIEMENS telegram 701 6040 6040 13374[15]
DriveAxis17 SIEMENS telegram 903 6956 752 -
DriveAxis17 SIEMENS telegram 701 6056 6056 13374[16]
DriveAxis18 SIEMENS telegram 903 6972 736 -
DriveAxis18 SIEMENS telegram 701 6072 6072 13374[17]

Table A-19 NX on DRIVE-CLiQ socket X103; DP address 13: I/O addresses of PROFIsafe/PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis19 SIEMENS telegram 903 6988 720 -
DriveAxis19 SIEMENS telegram 701 6088 6088 13374[18]
DriveAxis20 SIEMENS telegram 903 7004 704 -
DriveAxis20 SIEMENS telegram 701 6104 6104 13374[19]
DriveAxis21 SIEMENS telegram 903 7020 688 -
DriveAxis21 SIEMENS telegram 701 6120 6120 13374[20]
DriveAxis22 SIEMENS telegram 903 7036 672 -
DriveAxis22 SIEMENS telegram 701 6136 6136 13374[21]
DriveAxis23 SIEMENS telegram 903 7052 656 -
DriveAxis23 SIEMENS telegram 701 6152 6152 13374[22]
DriveAxis24 SIEMENS telegram 903 7068 640 -
DriveAxis24 SIEMENS telegram 701 6168 6168 13374[23]

Table A-20 NX on DRIVE-CLiQ socket X102; DP address 12: I/O addresses of PROFIsafe/PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis25 SIEMENS telegram 903 7084 624 -
DriveAxis25 SIEMENS telegram 701 6184 6184 13374[24]
DriveAxis26 SIEMENS telegram 903 7100 608 -
DriveAxis26 SIEMENS telegram 701 6200 6200 13374[25]
DriveAxis27 SIEMENS telegram 903 7116 592 -
DriveAxis27 SIEMENS telegram 701 6216 6216 13374[26]
DriveAxis28 SIEMENS telegram 903 7132 576 -
DriveAxis28 SIEMENS telegram 701 6232 6232 13374[27]
DriveAxis29 SIEMENS telegram 903 7148 560 -
DriveAxis29 SIEMENS telegram 701 6248 6248 13374[28]
DriveAxis30 SIEMENS telegram 903 7164 544 -
DriveAxis30 SIEMENS telegram 701 6264 6264 13374[29]
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Table A-21 NX on DRIVE-CLiQ socket X101; DP address 11: I/O addresses of PROFIsafe/PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis31 SIEMENS telegram 903 7180 528 -
DriveAxis31 SIEMENS telegram 701 6280 6280 13374[30]
DriveAxis32 SIEMENS telegram 903 7196 512 -
DriveAxis32 SIEMENS telegram 701 6296 6296  
DriveAxis33 SIEMENS telegram 903 7212 496 -
DriveAxis33 SIEMENS telegram 701 6312 6312  
DriveAxis34 SIEMENS telegram 903 7228 480 -
DriveAxis34 SIEMENS telegram 701 6328 6328  
DriveAxis35 SIEMENS telegram 903 7244 464 -
DriveAxis35 SIEMENS telegram 701 6344 6344  
DriveAxis36 SIEMENS telegram 903 7260 448 -
DriveAxis36 SIEMENS telegram 701 6360 6360  

Table A-22 NX on DRIVE-CLiQ socket X100; DP address 10: I/O addresses of PROFIsafe/PROFIdrive telegrams
Drive Telegram type I/O address (ONE) I/O address (840D sl) MD (ONE)
DriveAxis37 SIEMENS telegram 903 7276 432 -
DriveAxis37 SIEMENS telegram 701 6376 6376  
DriveAxis38 SIEMENS telegram 903 7292 416 -
DriveAxis38 SIEMENS telegram 701 6392 6392  
DriveAxis39 SIEMENS telegram 903 7308 400 -
DriveAxis39 SIEMENS telegram 701 6408 6408  
DriveAxis40 SIEMENS telegram 903 7324 384 -
DriveAxis40 SIEMENS telegram 701 6424 6424  
DriveAxis41 SIEMENS telegram 903 7340 368 -
DriveAxis41 SIEMENS telegram 701 6440 6440  
DriveAxis42 SIEMENS telegram 903 7356 352 -
DriveAxis42 SIEMENS telegram 701 6456 6456  
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A.7 Communication interfaces

Interfaces of a SINUMERIK ONE
SINUMERIK ONE uses PLC, CP and CM communication mechanisms based on the S7-1500 
product family, and therefore has different interfaces than a SINUMERIK 840D sl.

Figure A-3 Comparison of the configuration (network view): SINUMERIK ONE and SINUMERIK 840D sl

 Interface Type ONE 840D sl
Internal PROFIBUS DP Integrated x x
X120/X130, X127 Ethernet, PN-IE interfaces x

(individually con‐
figurable)

x
(not configura‐
ble)

X126 PROFIBUS DP x x
X136 MPI/DP - x
X150 PROFINET IO x x
X160 PROFINET IO x -
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A.8 Differences of NCU communication mechanisms

Support of NCU communications interfaces
The NCU communication interfaces (of CP/CM, PLC) are based on the related SIMATIC 
communication modules and mechanisms. New features and changes to the communication 
mechanisms, which are relevant when migrating from an S7-300 to an S7-1500, are also 
relevant when migrating from SINUMERIK 840D sl to SINUMERIK ONE, for example:
• PROFINET CBA is not supported
• Alarms are processed differently (alarm S/SQ is not supported)

An extension or a substitute for associated values is provided with S7-1500 (max. 10 
associated values possible) by using the alarm block Program_Alarm.

• System status queries are handled differently (no SSL)
The information in this manual is only intended as entry-level information and describes the 
special features of SINUMERIK. In addition to the information here, the information in the 
appropriate SIMATIC manuals applies:
• CPU-CPU Communication with SIMATIC Controllers Compendium (https://

support.industry.siemens.com/cs/document/78028908/)
• SIMATIC NET S7-1500 Industrial Ethernet CP1543-1 Manual (https://

support.industry.siemens.com/cs/document/76476576/)
• Guidelines for Migrating from SIMATIC S7-300/400 to SIMATIC S7-1500 and the TIA Portal 

(https://support.industry.siemens.com/cs/document/109478811/)
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